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Revisions Sheet 

Page Section Date Description 

5-6 1.3 04/2023 ▪ The process to download the current NCDOT workspace 

and launch ORD for ORD v10.10 was updated 

 8.5 09/2023 ▪ Side drain / driveway placement guidance has been 

changed 

- - 09/2023 ▪ Video links fixed 

 - 09/2023 ▪ Added Appendix C 

 15.2 09/2023 ▪ Updated path of where asset manager excel files are 

found in the workspace 

 4.6 09/2023 ▪ Added Section 4.6 Nodes: DSS Properties 

 4.1 09/2023 ▪ Added DSS Properties to table 

 4.7 09/2023 ▪ Added Section 4.7 Nodes: Pipe Elbows 

 8.1 09/2023 ▪ Added DSS Properties to table 

 15.3 09/2023 ▪ Minor updates to the exporting quantities process 

 15.4 09/2023 ▪ Added Section 15.4 – Generating DSS 

 15.5 11/19/2023 ▪ Added Section 15.5 – Printing DSS 

 10.4 03/20/2024 ▪ Added information about the ORD InletStormComp 

spreadsheet 

 8.2 03/20/2024 ▪ Inserted new Section 8.2 to show how to edit inverts and 

pipe sizes manually 

 9.1 03/20/2024 ▪ Added directions to ensure solver property “average 

velocity method” is set to “actual uniform velocity”  
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 4.3 03/20/2024 ▪ Updated information on the outfall boundary condition 

types 

 4.2 03/20/2024 ▪ Added guidance on ensuring inlets calculate bypass 

correctly (catalog inlet) 

 4.2 03/20/2024 ▪ Added guidance on how to change a non-CB inlet to a 

sag condition (by default they are set on-grade) 

 5.2 04/12/2024 ▪ Added guidance for the land use feature available in 

newer versions of ORD 

 10.2 09/25/2024 ▪ New process for beta Stormdrain system all spreadsheet 
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1.1 Introduction: OpenRoads Drainage and Utilities 

Introduction and Differences Between Other Software 

The Drainage and Utilities package in OpenRoads Designer (ORD) will take the place of 

Geopak Drainage for the design and analysis of certain hydrologic and hydraulic 

components for NCDOT projects.  A primary difference from other software is that all 

drainage data, components, computations, etc. are stored within the .dgn file and not 

in a separate file (no .gdf or other files).  

The following guide shows a new user the step-by-step process for inputting and 

analyzing the hydrologic and hydraulic components. Throughout this guide, there will 

be links to videos demonstrating different process and workflows. It is assumed the 

designer is familiar with the hydraulic and hydrologic analysis/design and it is the 

designer’s responsibility to adhere to all NCDOT Drainage Manual Standards. 

1.2 Introduction: Drainage and Utilities Workflow 

Recommended Process for Designing and Analyzing within Drainage and Utilities 

The following is the standard process recommended by NCDOT when completing the 

hydrologic and hydraulic design in ORD.  This process contains the same methodologies 

and concepts used in all analysis software, but the sequence of inputs most closely 

resemble the workflow in StormCAD. 

1. Create necessary terrain models 

2. Place nodes 

3. Add catchments 

4. Place gutters to direct bypass 

5. Run 4 in/hr scenario 

6. Check spread and adjust inlets as necessary 

7. Connect nodes with appropriate conduits 

8. Check design constraints 

9. Run design scenarios 

10. Check drainage profiles 

11. Adjust and run analysis scenarios 

12. Produce flex tables for review 
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1.3 Introduction: Opening the Hydraulics Workspace 

Getting Started in ORD with the Hydraulics Workspace 

When beginning the workflow, the user needs to ensure the latest NCDOT workspace is 

installed on the computer they will be using.  As of the time of this version of the manual, 

the most current workspace is for ORD version 10.10. The user can check the latest 

NCDOT ORD workspace download here: 

▪ https://connect.ncdot.gov/resources/CADD/Pages/default.aspx 

 

Once ORD has been properly installed on the user’s computer and the workspace folder 

unzipped and placed in the C: drive as shown below, the user may simply launch ORD 

from the task or windows search bar (the desk folder shortcuts previously used in 10.9 are 

no longer applicable).  

 

 

 

https://connect.ncdot.gov/resources/CADD/Pages/default.aspx
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▪ Select the DOT-US North Carolina Workspace, the project, and then 

NCDOT_Hydraulics Role 

 

▪ Create new file as appropriate (Section 2.1, Section 3.1) 

 

▪ Projectwise guidance for consultants is located at the following links below. If the  

Work Areas has been associated with a Managed Workspace, the files will 

automatically download the most recent discipline standards for a file depending on 

which folder the file resides in. Otherwise, the workspace will need to be updated 

manually via the process above everytime an update to the workspace is made. 

 

Consultants Access for Projectwise 

 

NCDOT ProjectWise Explorer User Guide 

 

  

https://connect.ncdot.gov/resources/CADD/CADD%20Documents/Consultants%20Access%20for%20ProjectWise.pdf
https://connect.ncdot.gov/resources/CADD/CADD%20Documents/Consultants%20Access%20for%20ProjectWise.pdf
https://connect.ncdot.gov/resources/CADD/CADD%20Documents/NCDOT%20ProjectWise%20Explorer%20User%20Guide.pdf
https://connect.ncdot.gov/resources/CADD/CADD%20Documents/NCDOT%20ProjectWise%20Explorer%20User%20Guide.pdf
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8 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

2.1 Terrains: Creating Terrain Models From Survey .Tin Files 

Creating Contours and 3D Terrains from .tin Files 

The following is a brief overview of how to create terrains from a typical survey file in the 

.tin file format. A terrain in ORD will be used similarly to how a contour file was used in 

Microstation V8i but, also contains the capabilities of a 3D surface. 

▪ Create a new .dgn file named project #_survey_terrain from the NCDOT 3D seed file 

 

Helpful Hint: When working with Terrains, do not create/generate multiple terrains in a 

single file. Only having one terrain in an individual .dgn file will help speed up processing 

and design. 

 

▪ Select the OpenRoads Modeling Workflow from ORD Workflow drop down menu. 

 Navigate to Terrain Ribbon Tab > Create Tool Group > From File. Path to and select the 

appropriate .tin file 
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▪ Select Import and check to see that the terrain was imported successfully by visually 

inspecting the contours and by referencing in the survey or other project file to 

ensure proper location. Exit out of the Import Terrain Model dialog box.  

Helpful Hint: If the user has a .dat file instead of a .tin file, follow the same steps as 

above but select the .dat file instead of the .tin file and for the “Edge Method” select 

“Remove Slivers” 

  

Global/File Options Typical User Selection 

Filter>Source File Units ▪ Most likely will be US Survey Feet for NCDOT Projects 

Feature Definition>Feature Definition ▪ Select the “ET_Contours” for existing ground  

Triangulation Options>Import Options ▪ Import Both 

Triangulation Options>Include Spot Features ▪ Leave unchecked 

Triangulation Options>Name all Features ▪ Leave unchecked 

Geographical Coordinate Systems>Source 
▪ Select North Carolina State Plane Coordinate System (Feet)  

EPSG:102719 
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2.2 Terrains: Creating Terrain Models From LiDAR 

Creating Terrains from .las Files for Offsite Drainage and Contours 

Drainage design often requires terrain data outside of the project survey limits. 2014 to 

2017 QL1/QL2 LiDAR data is typically downloaded from North Carolina’s Spatial Data 

Download Center as bare earth .las files. Legacy LiDAR files from 2001-2005 are 

available on the FRIS Data Download Center as a .txt file.  

NCDOT Internal users may wish to continue to use the ArcMap Tool Boxes, "Get 

Decimated Lidar" and "Extract DEM", to create a .dat file. Users can create an Existing 

Terrain Model from a .dat file by following the helpful hint on the previous page. 

▪ To create a terrain from a .las file, follow the first three steps of Section 2.1 above but 

select the .las file instead of the .tin file 

Helpful Hint: If the user cannot select a .las, .tin, or .dat file they may need to use the 

drop down in file explorer to change selection from “All files” to only “.las” (see 

screenshot below) 

 

▪ Most QL1/Ql2 .las tiles downloaded from the NC Spatial Data Center are large (>100 

MB per square mile) For large LiDAR Files, choose “import terrain only” (as shown in 

the screenshot below) under triangulation options.  This will allow for filtering that will 

make data more manageable. 

 

 

 

 

 

 

See Next Page for Screenshots 

  

https://sdd.nc.gov/DataDownload.aspx
https://sdd.nc.gov/DataDownload.aspx
https://fris.nc.gov/fris/Download.aspx?ST=NC
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▪ Typical Global/File options are slightly different for a .las and are shown below. 

▪ Filtering LiDAR will make working with the terrain model faster/easier and can still retain 

a high enough level of quality for most drainage applications. 

o The filter options shown above is for example purposes only. These settings 

reduce a typical NC LiDAR file by about 75%. 

o Different project types will require different levels of filtering. 

o Note: If the LiDAR is imported with non-ground points when only ground is 

selected, try exiting, detaching the .las file and not pressing “test filter”. This is 

a known bug for some types of LiDAR especially non-NC LiDAR.   

 

Helpful Hints: 

• If downloading FRIS legacy LiDAR in the form of a .txt file, the file will have to be 

converted to a .xyz and can then be selected and imported using the same 

process as shown above. 

• The user can initially ignore the “source file units” field under the filter tab. It will 

disappear when the geographical coordinate system EPSG:102719 is selected.   
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2.3 Terrains: Clip Terrain Models 

Clipping Unnecessary Data from a Terrain 

It is often the case that LiDAR tiles are much larger than necessary for the project limits. 

To reduce file size and memory usage, the user can clip a terrain by following the steps 

below: 

Draw a shape of the area to be clipped (shape can be on any level). 

▪ Select the OpenRoads Modeling Workflow from ORD Workflow drop down menu. 

▪ Select the Terrain Ribbon Tab > Additional Methods > Create Clipped Terrain Model 

as pictured below. 

 

▪ The Create Clipped Terrain dialog box will open 

  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

14 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

 

▪ Click through the options until the clipped terrain is created. It will be created on top 

of the original terrain so the user will need to delete the original (unclipped terrain) by 

selecting it, hovering over it and then clicking delete as shown below. 

 

▪ In addition to this, delete the shape that was used to create the clipped terrain 

  

Clip Terrain Option Description 

Reference Terrain Model ▪ Select the terrain model to be clipped 

Clipping Method 
▪ Use “External” to delete everything outside of the shape drawn 

▪ Use “Internal” to delete anything inside the shape drawn  

Horizontal and Vertical offset 
▪ Typically set to zero. If set to any other number, the terrain will be 

clipped by an offset of the shape drawn 

Feature Definition ▪ For existing terrains use the ET_Contours feature definition 

Name ▪ Name of the terrain i.e. “Clipped_Terrain_#” 
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2.4 Terrains: Merge Terrain Models 

Combine Multiple Terrains into One 

It is often helpful to merge terrains to create a model that has data from multiple 

terrains (LiDAR, Existing, Proposed, etc).  At the beginning stage, the survey terrain is 

typically merged with the LiDAR. If the user does not need to merge terrains, this section 

can be skipped.  

Before starting, the user must ensure that each terrain model to be merged is in a 

separate .dgn file.  A new .dgn (3D seed file) should be created that will house the 

merged terrain model.   

▪ To begin, open the new, blank .dgn file and reference in each terrain model that 

needs to be merged.  

 

▪ Select the OpenRoads Modeling Workflow from ORD Workflow drop down menu. 
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▪ To Merge terrains, select  Terrain Ribbon Tab > Create Tool Group > Additional 

Methods > Create Complex Terrain Model 

▪ Add the “Primary” terrain model to begin.  The Primary terrain model serves as the 

base terrain.  Any data that overlaps the Primary terrain model will govern and over-

write the Primary terrain model data.  Add terrain model(s) to Merge and add to the 

process order. 

 
▪ Select appropriate feature definition and select finish. 

Helpful Hint: Merge action will overwrite the primary data where the models overlap.  

Append action should be used when user needs to add to the primary data (ex. 

Combining LiDAR panels that are next to each other but not overlapping). 
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2.5 Terrains: Proposed Terrain Models 

Creating Proposed Contours and Terrain Based on a Roadway Design Model 

If a proposed terrain model is not provided for the user by the roadway designer, it can 

be created using the CMD (Corridor Model) file from roadway. A new .dgn (3D seed file) 

should be created that will house the proposed terrain model.  It is often useful to create 

a proposed terrain and then merge it with the survey-LiDAR terrain as outlined in Section 

2.4 above. The following steps outline this process as well as this VIDEO LINK. 

 

▪ Reference the CMD file and turn off all levels that are not associated with the top 

surface (subgrade levels, grading levels, default, etc.). 

Helpful Hint: Turning off the 3D version of the roadway CMD Design file will turn off most 

subsurface roadway levels so that they are not accidentally selected (see screenshot 

below) 

 

▪ Highlight all the elements (using the element selection tool) from the CMD file that 

were isolated in the first step and keep them highlighted for the next few steps. 

▪ Select the OpenRoads Modeling Workflow from ORD Workflow drop down menu. 

▪ To create the proposed terrain, select  Terrain Ribbon Tab > Create Tool Group > From 

Elements 

  

https://www.youtube.com/watch?v=nNM6T7eLC8Q
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▪ Select feature type “break line”, appropriate feature definition “PT_Contours” and 

other settings as shown below  

 

▪ Left click through the options until the proposed terrain is created 

▪ Open the cross section view for the corridor model and compare it to the created 

terrain for accuracy (see video below) 

VIDEO LINK 

Note: The proposed terrain is live-linked / connected to the CMD elements that it is built 

from. If roadway makes profile changes and then updates the corridor elements, the 

proposed terrain will automatically update with it.   

https://www.youtube.com/watch?v=GI4kaWXgzNM
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2.6 Terrains: Display Contours 

Contour displays, as well as contour text, can be turned on/off as follows: 

▪ Select the limits of the terrain model and display properties (for guidance on how to 

open properties see Section 3.2) 

 
 

▪ Selecting Contours allows the user to display major and/or minor contours as well as 

turn on and off text. 

 

▪ Typically, the .dgn that houses the terrain of interest will be referenced into the 

drainage .dgn or another .dgn that the user is working in. 

 

1. When this is the case, the user should follow the steps on the next page to change 

the contour settings 
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▪ Right click the terrain model in the properties window and select “Override 

Symbology” as shown below. 

▪ The terrain display properties can now be customized for the drawing you are in. To 

revert back to settings in the actual terrain file, follow the same steps except select 

“Remove Override Symbology” as shown below 

 

▪ To change the contours major and minor intervals, expand the calculated features 

tab and select just the “contour” tab as shown in the screen shot below 

 

▪ The major and minor interval can be customized by user entering the values (default 

values are 5.0’ and 1.0’) 

  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

21 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

3.1 Drainage Modeling Initial Setup: Workflow 

Setting the Active Workflow 

The Drainage and Utilities software is embedded in each drawing file.  If a DRN file has 

not been created for the project, create a new .dgn file named project #_drn from a 

NCDOT 2D seed file.  

Helpful Hint: Since all drainage data is stored within the .dgn, always create a new .dgn 

file from an NCDOT 2D seed file when beginning a new project rather than copying in 

an old “go-by” project file.  

To activate this software and create a new model, select the Drainage and Utilities 

Workflow from ORD Workflow drop down menu as shown below. 

 

▪ Once Selected, the ribbon bar tabs at the top will change to the default Drainage 

and Utilities 

▪ If it is a new design file, the user will need to select a Drainage and Utilities 

component and click to insert it into the drawing (follow video instructions below).  

The user will be prompted to “Create Dainage and Utilities Project” that will reside 

within the drainage .dgn file.  When working in the NCDOT workspace, creating a 

utility model will embed NCDOT drainage libraries and setting into the .dgn file.    

VIDEO LINK 

  

https://www.youtube.com/watch?v=dOrCXFjn190
https://www.youtube.com/watch?v=dOrCXFjn190
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3.2 Drainage Modeling Initial Setup: Property Tools 

Accessing and Setting Up the Commonly Used Property Tools 

The Drainage and Utilities workspace utilizes two different types of property windows to 

edit all the drainage element properties (nodes, conduits, catchments, etc.) The steps 

below outline how to access the two most used windows: properties, and utility 

properties 

▪ To access these property windows, go to the Utilities View Ribbon Tab and select 

both options outlined in red in the screenshot below. 

 

Properties: The standard informational properties that most users are familiar with (CADD 

properties such as level, color, feature definition, etc.)  

Utility Properties: Every available hydraulic property for a Drainage and Utilities element 

including customized properties. For example: an inlet would have variables such as 

spread criteria, elevations, efficiency, freeboard, and more which can be set using this 

window.  

▪ Both property windows will be used extensively throughout the drainage design. It is 

useful for both windows to be docked within the ORD interface for quick access by 

simply clicking and dragging them to the sides or tops of the screen. 
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3.3 Drainage Modeling Initial Setup: Explorer Tool 

Accessing and Setting Up the Commonly Used Explorer Tool 

The explorer tool is used to view all of the drainage components housed within the 

.dgn, many other components of the .dgn file and also components of any attached 

references. 

▪ To open the explorer tool navigate to the Home Ribbon tab > Explorer 

 

▪ The explorer window will open.  

 

▪ The explorer tool contains many different ways to navigate the components housed 

within the current .dgn. For example: Once a drainage system is created by 

following the rest of this guide, under the “Drainage and Utilities Model” tab, all the 

components are listed and can be right clicked, navigated to, etc. 
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▪ The explorer window will be used frequently. It is useful to dock this tool within the ORD 

interface for easy access by simply clicking and dragging it to the sides or tops of the 

screen.  
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3.4 Drainage Modeling Initial Setup: Other Helpful Setups 

Opening Common Toolbars for the First Time User and Using 2 Screens 

Other common toolbars that are used in drainage design and general drawing design 

are outlined below. It can be useful to dock these toolbars since they will be used 

extensively. In addition, opening two applications windows (helpful for dual screens, or 

even triple screens) is outlined below. 

▪ Civil Accudraw will be used to place nodes and as a station and offset finding tool. 

The screenshot below shows one of several ways to locate the tool and activate the 

toolbar. 

 

▪ AccuSnap will be used to lock on to key features and help place lines, nodes, and 

draw drainage areas. The screenshot below shows one of several ways to  
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▪ OpenRoads has one application window by default the first time a user installs the 

software. To set up multiple application windows for the use of two or even three 

screens (helpful for cross section/profile alongside plan view), follow the steps below. 

 

▪ Navigate to File > Settings as shown below. 

▪ Select “Preferences” as shown below. 

 

▪ Select “Operation” on the left panel and then check the box that states “Open 

Multiple Application Windows” as shown below. 

 

▪ Select how many application windows will open by default each time OpenRoads is 

launched as shown above.  
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4.1 Nodes: Placement 

Placing Nodes to be Referenced to Alignment and Model Elements 

In order for nodes to have top elevations calculated based on the proposed design 

and be referenced to the roadway alignment, they must be placed using the steps 

described below.  

▪ Select the Drainage and Utilities Workflow from ORD Workflow drop down menu. 

(Section 3.1) 

▪ To access nodes, go to the Layout Ribbon Tab > Place Node 

 

▪ The Place Node dialog box will open. This contains initial settings for the node 

components of Drainage and Utilities.   
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▪ Before placing a node, the user should activate Civil Accudraw as shown below. 

This will be used as a station/offset tool and will allow the location of the node to be 

input based on station and offset. 

▪ The station-offset option is shown selected above however, it is recommended the 

user follow the steps in Appendix A – Customized Civil Accudraw to create a custom 

option that will improve the node placement experience for specific scenarios. 

Helpful Hint: Ensure Civil Accudraw is associated with the current alignment first by using 

a command that will display it such as “draw line.” If it is not associated with the current 

alignment, press the “O” key (“O” stands for origin) in either the station or offset data 

field, hit enter, and it will prompt the user to select an alignment. If entering “O” in the 

station field does not work, <reset> (right click) and try entering it in the offset field.  

Place Node Option Description 

Feature Definition ▪ This is where the user will select the type of node to be placed. 

Name Prefix 

▪ This is where the user will name/number the node. NCDOT typical structure 

numbering should be followed (for example this node is named 0401). Keep 

an eye out for future versions of this document should recommended naming 

convention change based on labeling standards. 

Elevation 

▪ Elevation can be set manually here; however, this will be left unchecked most 

of the time. Elevation will typically be assigned based on a 3D linear element 

that is part of the roadway corridor model or the active terrain (see steps on 

next few pages for how to reference in terrains or roadway CMD file).  

Vertical Offset 

▪ If a constant elevation offset is needed such as gutter pan drop or local 

depression, that can be entered here. In the example above, a catch basin is 

set to -0.17’ if the gutter flow line elevation reference will be used. 

Baseline Reference 

▪ Select the alignment from the drop-down list that the node’s station and 

offset will be referenced from. Note: you must have the roadway alignment 

file referenced in for this to work (follow steps below). 

Rotation Mode 

▪ Choices are absolute or relative to alignment. Typically, relative to alignment 

will be used and the L or Y alignments can be selected in the drop down that 

appears. 

Rotation ▪ Set the angle of rotation here. 

DSS Properties 

▪ Grayed out properties with default values will automatically update once the 

node is placed. For non-grayed out properties, select the appropriate option 

now or later as appropriate (See Section 4.6 for more information). 

IMPORTANT: If the DSS Property is absent, place node, delete, and try again. If 

this still does not work, the workspace may be outdated - See Appendix C  

Catchment Delineation 

▪ This box can be checked to have the drainage area automatically created 

and auto delineated. This option only works when a terrain model will be 

selected for the node’s elevation reference. See the last paragraph of this 

section for more information on catchment auto-delineation. 
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▪ Reference in the roadway CMD (corridor model) file (.dgn file) and/or the 

proposed/existing terrain model (.dgn file) using the attach reference tool. 

 

▪ “Default” can be selected. If the CMD .dgn file has a 3D model within it, it will 

automatically attach a 2D and 3D version of the reference.  

▪ After the initial node options are set, the reference element for node elevation can 

be selected as shown below. Typically, one of three reference elements will be 

selected 

1. A 3D linear element (In the picture below, a 3D linear element in the 

roadway CMD file that represents the gutter flow line is being selected as 

the reference.) 

2. A terrain model (typically a merged combination of both proposed and 

existing terrains) 

3. No reference – user entered elevation (shown as <reset> i.e. right click)  
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Helpful Hint: If selecting a 3D linear element, use level display toggling and/or tentative 

Snap to ensure the appropriate element is being selected– it is very easy to select the 

wrong element – particularly in the curb line (the common level and element for catch 

basins to be referenced to will be the GTI_FL or another as shown in the screenshot 

above) Select the elevation reference and vertical offset (-0.17’ for catch basin’s local 

depression), then enter the station and offset into the accudraw fields. Left-click to 

accept the parameters (location, vertical offset, rotation).  Right-click through the steps 

at any time to exit the command.  

▪ The placement of the node is now complete 

▪ For special instructions on placing open end pipe nodes refer to Section 8.4 

▪ In addition to the steps above, a short video tutorial is available at the link below to 

provide further clarity on node placement. 

VIDEO LINK  

 

Helpful Hint: After a node has been placed, it can be selected, and basic elevation/ 

location properties will show up in orange text (as shown below). This feature can be 

utilized when needing to quickly adjust the rotation or elevation of a node. If the node 

has an elevation reference (3D element or terrain), the orange text elevation field will 

be a space to edit the offset elevation from the surface. If not, the field will simply be 

the ground elevation of the node. The node rotation arrow handles can also be used to 

rotate the node by clicking and dragging.  

https://www.youtube.com/watch?v=M0O4YEhqXoA
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Auto delineation When Placing A Node Referenced to A Terrain 

If the user is selecting a terrain model as the elevation reference instead of a 3D linear 

element, the catchment delineation feature can be used as shown below. 

This tool can be powerful and save time in creating and delineating catchments 

(Section 5.1). This tool should be used at the user’s own risk and the drainage areas 

should still be checked thoroughly and tweaked as needed since they are being 

delineated by the software and not the engineer. At this time, there still appear to be 

some restrictions that are associated with this tool such as the inability to manipulate the 

catchment vertices after creation. This guide will be updated based on Bentley’s future 

bug fixes and best practices. Please see Section 16.1 for NCDOT staff contacts to report 

bugs or other issues. 
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4.2 Nodes: Node Hydraulics / Node Utility Properties 

Setting Spread Criteria, Rim Elevations, Freeboard Etc.  

Select a drainage node by clicking on it and then open the Utility Properties as 

discussed in Section 3.2. The Utility Properties dialog box will open as shown below. 

▪ Notice the “notes field” contains default instructions by NCDOT for the node.  

▪ The default properties for the node are pre-populated from its catalog and prototype 

(explained in Section 4.5 below).  

▪ It is the responsibility of the user to change the applicable properties (catalog gutter, 

road cross slope, elevation, inlet location, etc.) depending on each specific node 

and circumstance.  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

33 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

Inlet Type Capture Efficiency 

Ensure that Inlet Type Capture Efficiency is set to the correct method. Earlier workspace 

projects may have a few inlets with the default set incorrectly. 

▪ Open the utility properties for the node (see Section 3.2) or the prototype definition 

of the node (see Section 4.5) 

▪ Change the “Inlet Type” to “Catalog Inlet” as shown below. 

▪ Now the inlet is no longer assuming 100% capture efficiency and will calculate 

bypass. 

Inlets in Sags  

By default, the CB-E catalog inlet has inlet settings set to the correct sag settings however, 

if the user has a drop inlet, 2GI or other inlet that needs to be set as a sag, follow the steps 

below. 

 

▪ Open the utility properties for the non-CB node (see Section 3.2) 

▪ Change the “Inlet Location” from “On Grade” to “In Sag” 

▪ Change the “Clogging Factor %” to 50.0 

▪ The process is complete. 

  

https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_3.2_Drainage_Modeling
https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_3.2_Drainage_Modeling
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4.3 Nodes: Outlets 

Node Outlet Options and Guidance   

Outlet placement is done with the same relative process as outlined in Section 4.1 

▪ The Place Node dialog box with the outlet node types is pictured below. 

 

▪ Headwalls (in the headwalls folder shown in the screenshot above) can be placed 

as either an outfall node or an inlet node and the software will change them 

automatically depending on how pipe conduits connect them (see Section 8.1 for 

conduit placement). 

Helpful Hint: It is likely that the outlet pipe size is not known yet and will require unknown 

riprap size and/or endwall size. In this case, select the feature definition as “NCDOT 

OPEN END PIPE ALL DIAMETERS, NO RIPRAP, NO ENDWALL” then, once the system is 

completely designed with an appropriately sized outlet pipe, the user can change the 

feature definition using the properties tool.  
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▪ Recommended settings for outlet nodes will vary from inlet nodes as shown below. 

 

 

▪ The typical elevation reference for an outlet will be the existing terrain/merged 

terrain (or user input) as opposed to a roadway CMD element. 
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▪ After the outlet is placed and rotated properly, open the utility properties for the 

outlet node (see Section 3.2) 

 

▪ Notice the notes field provided by NCDOT and change the boundary condition as 

necessary. Boundary condition selections are discussed more in depth on the next 

page. 
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▪ The screenshot below shows the boundary condition options. 

 

 

 

  

Boundary Condition Option Applicability / Description 

Boundary Element 
▪ This will rarely be used.  It allows the user to select a Drainage and 

Utilities element that will receive the outfall discharge. 

Crown 
▪ This will rarely be used. This sets the tailwater elevation at the crown of 

the outfall conduit. 

Elevation-Flow Curve 
▪ This will rarely be used.  It allows the user to define tailwater elevations 

based on the flow being discharged. 

Free Outfall 

▪ This is recommended for most situations - allows the program to select 

the appropriate depth depending on the flow regime. Free Outfall 

means that hydraulically steep pipes will have a minimum tailwater of 

normal depth and mild sloped pipes will have a minimum depth of 

critical depth. 

Normal 
▪ This method does not work with the solver that NCDOT uses. Normal in 

this case means the normal depth of the upstream conduit. 

Tidal 

▪ This will rarely be used. It allows the description of elevation changes 

over time. For coastal projects, users should use the most conservative 

tide elevation and the “User Defined Tailwater” option. 

Time-Elevation Curve 
▪ This will rarely be used.  It allows the user to define tailwater elevations 

based on time. 

User Defined Tailwater 

▪ This will be used regularly when boundary conditions exist with a known 

elevation that will not vary.  It allows the user to enter an elevation 

used for the tailwater. 
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4.4 Nodes: Adjustments 

Changing Structure Type or Adjusting Elevation After Placement 

Situations may arise where a node type must be changed from one to another or 

rim/top elevations edited. The steps below outline the basic procedures to edit these 

properties. 

To change a node’s type after placement, follow the steps below. 

▪ Select the node and open its properties. Locate the feature definition drop down in 

the properties as shown below. 

 

 

▪ Use the drop down (circled in red above) to select the new node type. 

▪ The node type has now been changed. Update elevations and other characteristics 

accordingly depending on the type of node. 

 

To edit a node’s elevation after it has been placed follow the steps below.  

▪ Select a node, open its utility properties, and navigate to the “physical” properties 

tab (see screenshot next page.) 
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▪ Rim elevations can be changed under the Physical properties as shown in the 

screenshot above 

 

▪ Notice that in the screenshot above Set Rim to Ground Elevation? is set to true. When 

this is set to true and the node’s elevation is referenced to a terrain or roadway CMD 

element, the rim elevation of the node cannot be changed. In this scenario, the 

elevation of the node will be automatically updated when the CMD element or 

terrain is updated. (note: the proposed terrain will automatically update with the CMD 

it is referenced to - see note at end of Section 2.5) 

 

▪ If the user still wishes to change the elevation, Set Rim to Ground Elevation? should be 

changed to false and the Elevation (Rim) (ft) field can be now be edited manually. 

Note: This unlinks the rim elevation from the associated terrain model or CMD element. 

When the terrain or CMD element’s elevation is updated, the Elevation (Ground) (ft) 

will change automatically, but the Elevation (Rim) (ft) will remain as what the user has 

input.  

 

Helpful Hint: When deleting a node, it is best practice to delete the conduit attached to 

it first, then delete the node. This helps avoid possibly corrupting the drainage network.  
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4.5 Nodes: Background Data 

Miscellaneous Inlet Components (for Information Purposes Only) 

▪ The Inlet Catalog is where default grate type, grate size, and structure size are 

housed. It is located at Components Ribbon Tab > Catalog Drop Down > Inlet 

Catalog 

 

o The catalog should be used for information purposes only. Editing it should be 

done at the users own risk. It is not recommended to edit the default NCDOT 

inlets. In rare situations, inlets can be duplicated, and new ones created. 

o If any commonly used inlet is missing or errors are found in catalog items 

please refer to Section 16.1 to contact NCDOT 

 

▪ Additional Node/Inlet properties and types are also stored in the Prototypes library 

located at the Components Ribbon Tab > Prototypes 

 

o The Prototypes library should be used for information purposes only. Editing it 

should be done at the users own risk. 

 

Helpful Hint: A drainage Feature Definition (such as a CB 840.03 G) is typically a 

combination of a prototype, catalog (if applicable) and a graphic cell. 
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4.6 Nodes: DSS Properties 

Viewing and Choosing DSS Payitems 

The DSS Properties are custom properties that ORD calls “Item Types”. As outlined in 

Section 4.1, the DSS item type properties are already attached to the definition of a 

drainage element and are viewable immediately after placement. If the drainage file 

was created prior to Fall of 2023, these properties may be missing due to an outdated 

workspace – see Appendix C on how to correct this and retroactively apply the 

properties. 

▪ To view the DSS properties of a drainage element, select the drainage element and 

then view its properties (Section 3.2) 

▪ If the drainage element has not had an alignment assigned to it yet, it will appear as 

above.  

▪ The categories in black text can be user edited/entered (for example: the DSS 

Comments field above). 
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▪ Other drainage elements have DSS property drop downs that must be selected 

before the drainage design is finalized, or else they will not be accounted for in the 

drainage summary sheet generation.  

▪ For example, the image below is for a convert. The drop downs shown boxed in red 

must be selected before the DSS is generated (See Section _ for DSS generation). 

 

 

▪ Additionally, if pipe elbows are placed as nodes, they will need to have their size 

selected in a similar manner.  

▪ See the next section (Section 4.7) for guidance on modeling pipes with elbows. 

 

Troubleshooting: If the user is running ORD 10.10 and the alignment and station are 

appearing incorrect or blank but are appearing correct in the other property fields, the 

user should upgrade the file to 10.12 (by opening it in 10.12). Note: The file would only 

need to be upgraded to 10.12 for the DSS export, so a copy of it could be upgraded to 

10.12 just for the DSS/quantities if the user prefers to keep the original file in 10.10  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

43 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

4.7 Nodes: Pipe Elbows 

Guidance on the different ways to model/account for pipe elbows 

▪ There are two options for modeling pipe elbows as outlined below: 

1. A pipe elbow may be individually modeled in 3D by placement as a node with 

its own node ID and associated pipe (following the guidance of node placement 

in Section 4.1) 

2. The pipe elbows can be excluded from the 3D model, but accounted for in the 

DSS by setting the DSS Property on a conduit to “yes” (see conduits Section _) 

 

▪ Option #1 requires more user effort and modeling because it results in a total of 4 

nodes and 3 pipe conduits for a typical system (upstream inlet/junction, pipe #1, 

elbow #1, pipe #2, elbow #2, pipe #3, downstream inlet/junction). 

 

▪ However, Option #1 is the only way to accurately model pipe elbows in 3D. 

 

▪ Currently, there are not separate feature definitions of each 3D size pipe elbow so 

there is not a way to accurately model pipe elbows in 3D and have them show up to 

scale (there are only 4 feature definitions corresponding to material - see image 

below) 

INSERT IMAGE 

 

▪ Whether or not a pipe with elbows will need to have the elbows be modeled in 3D as 

their own nodes will be up to the engineer and reviewers to determine as applicable 

on a case-by-case basis until further guidance is issued.  
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5.1 Catchments: Placement 

Placing Drainage Areas and Assigning Them to Nodes 

ORD refers to drainage areas as “catchments”. Catchments are placed by drawing 

shapes. They must be placed using the workflow described below.  

▪ To place catchments, go to the Layout Ribbon Tab > Place Catchment 

 

▪ The Place Catchments dialog box will open 

 

Place Catchment Option Description 

Method ▪ Three options: Pick Points, Pick Shape, Flood Fill 

Feature Definition 

▪ This is where the land use will be selected. At this time only 

one C-Value can be selected however, the C-Values can be 

edited individually for each catchment after placement (see 

 below). If the C-Value will be edited individually it 

does not matter which feature definition is chosen, but it’s 

recommended a logical one be chosen. 

Name Prefix 

▪ This is where the user will name the catchment (name should 

correspond to node associated with the catchment. NCDOT 

typical structure and area numbering should be followed (for 

example this node and catchment are named 0401) 
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▪ After the user selects points or a pre-drawn shape as the catchment, the option to 

select outflow will appear. This is where the node associated with the catchment will 

be assigned. Hover over the node to assign till it is highlighted as shown below. 

 

Helpful Hint: Right click is the same as <reset> to continue without selection 

 

▪ The next step is to select the terrain associated with the catchment.  Hover over any 

part of the terrain and select it as shown below. If the user prefers to not assign a 

terrain, they can simply right click. A terrain can be assigned later or changed if 

needed. Assigning a terrain will not affect the design but will allow the drainage 

area to be viewed in 3D (Section 13.1). 
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5.2 Catchments: Time of Concentration and C-Values 

Using the Utility Properties to Set the Time of Concentration and C-Values 

▪ To set the time of concentration and C-values for a catchment, select the area and 

open the Utility Properties under the Utilities View Ribbon Tab (Section 3.2) 

 

▪ The catchment’s Utility Properties can also be accessed by selecting the catchment 

and hovering over the catchment until the quick toolbar button appears as shown 

below. 
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▪ Click the utility properties button and the catchment’s utility property’s dialog box 

opens. 

 

 

▪ Time of Concentration and C-Values are edited in the runoff category outlined in red 

above. NOTE: The user should not change the runoff method from the default rational 

method for standard NCDOT storm drainage systems. More complex methods are not 

outlined in this document – user should only use other methods after consultation with 

NCDOT reviewer. 

▪ Even though the minimum time of concentration is 10 minutes, the time of 

concentration for catch basins with small, impervious drainage areas should be set 

to  a more realistic number (typically a very small number such as 2 minutes). The  

more realistic (smaller) time of concentration will only be used for calculating the 

accumulating system time and using a small number will prevent the accumulating 

system time from going above the 10 minute minimum before it should. The flows 
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that are calculated and used for pipe sizing will be based off of the minimum 10-

minute rainfall intensity values even though the more realistic,entered, time of 

concentration is less than 10 minutes.  

▪ Time of Concentration can also be broken up into multiple calculations instead of 

being user entered as shown below. To add the different collection items as shown 

below, use the “new” button circled in purple. 

 

▪ Many different time of concentration methods are available to use. NCDOT 

recommends the TR-55 method as shown above.  

 

▪ In most cases the runoff coefficient will need to be weighted based on the relative 

percentages of different land uses within it.  

 

▪ With the release of ORD v10.12 there is now a way to draw land use shapes that 

have a hydraulic feature definition. Each feature definition has an associated C-

value which allows auto-delineation of land use for catchments. 
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▪ To place land use, go to the Layout Ribbon Tab > Place Land Use Area 

 

▪ The Place Land Use dialog box will open 

 

 

▪ After the user selects points or a pre-drawn shape, the land use shape is created. 

Note that if land use shapes overlap the composite C-value of the overlapping 

shapes is NOT taken. The C-value from the latest land use shape will be used in 

catchment C-value calculation. 

 

 

 

Place Catchment Option Description 

Method ▪ Three options: Pick Points, Pick Shape, Flood Fill 

Feature Definition 

▪ This is where the land use will be selected. Open the feature 

definition drop down > Drainage Area > Surface Polygon. 

Note that there are feature definitions for both existing and 

proposed land use. Also note that the corresponding C-value 

to the feature definition is at the end of the feature definition 

name. 

Name Prefix 

▪ This is where the user will name the land use. It is 

recommended to just leave it as is and the software will auto 

name with the next available number. (For example, LU-1, LU-

2, LU-3, etc.) The name does not affect any calculations. 



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

50 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

▪ The system/inlet analysis in Section 7.1 must be run to see the composite C-value of 

a catchment. Shown below are multiple land use shapes within a catchment. When 

the analysis is run the composite C-value in each catchment is calculated based on 

C-value and area of each land use shape. The calculated C-Value can be viewed 

in the catchment utility properties page. Open the catchment utilities property 

page by clicking and hovering on the catchment until the utility properties option 

appears. 

 

 

 

  

file://///kimley-horn.com/CL_RAL1/RAL_Roadway/011036577%20-%20SUDA%20Support/SUDA%20User%20Manual/Drainage%20Manual%20Sixth%20Draft.docx%23_7.1_Spread_&_1


 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

51 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

▪ The automatically calculated C-Value is shown under Runoff Coefficient (Rational 

Composite). Note that Rational C (Default) must be inputted for each catchment. If 

no default C-Value is chosen, the default will be set to zero, and the composite C-

Value may decrease greatly. 
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Other options for weighted C-values are available as shown below however, for NCDOT 

projects theses should rarely be used and are not recommended. 

 

 

▪ “Area Defined By” Input field (shown in the screenshot below). It can be changed to 

multiple areas as shown below to produce a weighted C-value.  

▪ A more burdensome option to calculate a composite C-Value is to assign multiple 

catchments to one node. ORD does not have a limit on how many drainage 

areas/catchments can be sent to a single node. See below for the standard 

practice to assign multiple drainage areas with different land uses to a single node. 
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▪ Place the first catchment (Section 5.1) in the first land use sub-area. In this example, 

the first area will be the grassed area draining to the 2GI in the ditch and will use the 

“NCDOT Prop Grass C 0.3” feature definition. The name of the catchment should be 

the name of the node followed with A, B, C, etc. depending on how many 

catchments the user is assigning. 

▪ After the first catchment is placed, create another catchment for the next land use. 

In this example, the proposed roadway draining off the paved shoulder and to the 

2GI in the ditch will use the “NCDOT Prop Impervious C 0.9” feature definition. Note 

the name of the second catchment, “0610B” 

▪ Once all catchments have been placed and the system/inlet analysis is run in 

Section 7.1, the software will automatically calculate the composite C-value and 

use it for the inlet and system calculations. However, each catchment will still retain 

its original C-value and peak flow when its utility properties are viewed separately. 

Helpful Hint: Multiple catchments can be useful in rare situations where flow from an 

impervious sub-area calculated by itself is higher than the flow from the entire, larger 

area with a weighted C-value. This occurs when a smaller wooded/grass sub-area with 

a high time of concentration is weighted with a large impervious sub-area with a low 

time of concentration. Drainage and Utilities does not account for using the higher flow 

however, when multiple catchments are used as outlined above, each catchment’s 

flows can be checked to verify if this situation is occurring. If it is, then the catchments 

can be manipulated accordingly to represent only the highest flow from the impervious 

sub-area. 
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6.1 Gutters: Overview 

Explanation of Gutter Capabilities and Purpose 

Gutters in the Drainage and Utilities model workspace are slightly confusing because 

they are separate from the roadway gutter linework/elements. For NCDOT projects, the 

main (and required) purpose of these gutters is to assign bypass flow from an upstream 

inlet to a downstream inlet. Gutters placed in the Drainage and Utilities model represent 

only a hydraulic connection between nodes. They are not to be confused with and are 

not part of roadway’s physical gutter design in the 2D/3D model.  

Other than using gutters to assign bypass, they also can be used to analyze spread. This 

feature is mostly redundant because the spread of interest is typically taken at the inlet 

and not at random places along the gutter. At this time, it is recommended that gutters 

be used mainly for purposes of assigning bypass and the inlet computations used to 

check spread. 

6.2 Gutters: Placement 

Using the Gutter Placement Tool to Connect Nodes 

As mentioned in the section above, bypass is assigned in ORD by placing a gutter 

connection between two inlets. 

▪ To place a gutter connection and assign bypass, go to the Layout Ribbon Tab > 

Place Gutter 

 

▪ A warning message may pop up below to turn on Analytic view. Click yes to turn on 

Analytic view. Gutters can only be viewed in analytic view. 
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Helpful Hint: Analytic View is also used to turn on and off labeling/ sets of labels for 

drainage elements. This labeling is only a visualization and not a permanent / moveable 

text element. For more clarification on this process, Section 12.2 covers this labeling and 

sets of labels in more depth.  

 

▪ The Place Gutter dialog box will open (see next page) 

 

 

 

 

Place Gutter Option Typical User Selection 

Curve Variables ▪ Leave unchecked 

Method ▪ NCDOT users should select between nodes 

Feature Definition 

▪ Use the drop down to select the C&G type that connects the elements.  

▪ If there is a super elevation transition where flow in the gutter would cross 

the road to the next inlet use the feature definition “NCDOT Super 

Transition.” This is a generic gutter section that should only be used for 

bypass assignment purposes. 

▪ A gutter with a negative road cross slope or gutter cross slope cannot be 

used (system will not run).  

Name Prefix 

▪ Name the gutter connection after the upstream node. Since gutters are a 

type of conduit you will have to add a “-G” after the name so that it does 

not conflict with the pipe conduit names. 

Description ▪ No descriptions are available at this time, leave as default 
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▪ After the selections are made above, select the start node for the gutter 

placement. Note that there are specific snap points on each side of the node which 

will show up as orange crosshairs. 

 

▪ The user can either snap directly to the downstream node to assign the bypass or hit 

(not hold) CTRL to place bends in the gutter connection (not recommended unless 

gutter is curved).  

▪ Select the downstream node for the gutter connection and the gutter linework will 

appear. Note: It may be difficult to see the gutter linework as it is usually plotted 

directly on top of pipe connections. Turning on and off appropriate levels when 

necessary can fix this problem so that the gutter can be seen/selected.  

▪ Gutter properties are viewed the same way that node properties are viewed as 

outlined in Section 3.2 (properties and utility properties). 

6.3 Gutters: Advanced 

Complex Gutter Sections and Spread at Intervals 

More advanced features of gutters include using “Gutter Sections” for varying 

geometry gutter sections (i.e. super elevation transitions) or for viewing spread 

incrementally along a gutter rather than just the start and end. This requires a proposed 

terrain and the software will automatically cut gutter sections (cannot be user defined). 

At this time, due to the lack of flexibility and some bugs encountered, the “Gutter 

Sections” feature will not be outlined in this document. Future versions of this manual will 

incorporate these advanced tools as they become more reliable and useful on NCDOT 

projects. 
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7.1 Spread & Inlet Computations: Running Scenarios 

Using the NCDOT 4.0 Inch/Hour Scenario to Calculate and Analyze Spread 

Before adding pipe conduits and running an entire system, it is recommended to run 

the spread analysis and make any necessary changes to inlet locations. To run the 4.0 

inch/hour spread analysis, follow the steps below. 

▪ Under the Drainage and Utilities workflow, navigate to the Analysis Ribbon Tab > 

Scenarios > Scenario Manager 

▪ The scenarios dialog box will open. Highlight the NCDOT 4 inch / hour Analysis and 

click the green arrow to compute 
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▪ The calculation summary dialog box will open after the calculations are complete. 

Warnings and errors can be viewed by clicking the messages button outlined in red 

below  

or by selecting the notifications option as shown in red below 

 

▪ Note: If the “calculation summary dialog box” does not open automatically after the 

“compute” is run, open it by clicking the option in the screenshot below  

 

▪ The box that states “Show this dialog after Compute” can be checked so that the 

dialog box appears after every compute. 
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▪ There will be warnings and errors since the system is not yet complete. Typical 

warnings and errors at this step in design are shown below. 

 

Helpful Hint: If an error or warning message is double clicked it can automatically take 

the user to where the error/warning is occurring  

In addition to the warnings and errors shown in the “User Notification Details” dialog box 

above, there will also be warning notifications that appear in plan view that resemble 

yellow yield signs (see screenshot below next bullet). 

▪ The user can hover review the design in plan view and hover over one of these “yield” 

symbols until a description of the warning/error is displayed next to the cursor. This can 

be helpful when a user has many systems/nodes and needs to review errors/warninga 

in one specific area of the design in plan view.   
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7.2 Spread & Inlet Computations: Viewing Results 

Using the Utility Properties to View Inlet Computations 

After the NCDOT 4 inch / hour scenario has been run, typical inlet computations such as 

spread, bypass and inlet efficiency can be checked by viewing the Utility Properties. 

▪ Select a node and open the utility properties (Section 3.2) Scroll down to the results 

section in the utility properties window to view calculation results. 

 

▪ Spread, bypass, inlet efficiency and many other calculations are shown.  

▪ Users may also prefer to check spread calculations by using summary tables called 

Flex Tables (guidance on Flex Tables is outlined in Section 10.1) 

▪ For sag inlets, spread left and right will need to be verified with another software and 

reported in the final computations package.  

Helpful Hint: If bypass flow and inlet efficiency are not being computed, the user may 

need to scroll up and change Inlet type from 100% efficiency to Catalog inlet (see 

below) 
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8.1 Conduits: Placement 

Using Conduits to Connect a System 

After the inlets are appropriately spaced and the designer is confident in the layout, the 

nodes will be connected using conduits. In ORD, conduits will mainly be used for pipe 

connections. Conduits may also be used as channel connections; however, this section 

will focus solely on pipes.  

▪ Under the Drainage and Utilities workflow, navigate to the Layout Ribbon Tab > 

Place Conduit 

 

▪ The place conduit dialog box will open 
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▪ After the selections are made above, select the start node for the conduit 

placement. Note that there are specific snap points on each side of the node which 

will show up as orange crosshairs. 

 

▪ Select the downstream node and the conduit link will appear.  

▪ Both a 3D and 2D element will be drawn. The 3D elements are stored in a separate 

reference of the active .dgn as shown below. The 3D reference should be turned off 

for this view. A second view can be opened for the 3D model space (see Section 

13.1)    

Place Conduit 

Option 
Typical User Selection 

Curve Variables ▪ Leave unchecked 

Slope 

▪ If a design slope is desired, this box can be checked. When you are placing the 

conduit, the slope in this field will automatically calculate based on the node 

bottom elevations. 

Feature Definition ▪ Use the drop down to select the type of pipe (channels are also an option) 

Name Prefix ▪ Name the conduit connection after the upstream node (ex. 0401) 

Description 

▪ This is where pipe size will be selected 

▪ Helpful Hint: The software will design pipe sizes for the user at a later step so a 

generic size (i.e. 15-18”) can be chosen initially for all conduits. 

DSS Properties 

▪ Grayed out properties with default values will automatically update once the 

conduit is placed.  

▪ The property “Elbows?” is set to “No” by default this should only be set to “Yes” if 

the pipe will have elbows AND if the elbows are not being modeled in 3D (See 

Section 4.7 for guidance on pipe elbows and what to do for 3D).  

▪ IMPORTANT: If the DSS Property is absent, place the conduit, delete it, and try 

again. 
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Helpful Hint: If a conduit is placed with one material and later needs to be changed to 

another (example: RCP to CMP), the n-value may not update and should be double 

checked and changed by hand if needed.  
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8.2 Conduits: Editing Inverts and Pipe Sizes 

How to Manually Design Conduits 

In order to manually set pipe inverts and sizes follow the steps below 

▪ Open the Utility Properties for a selected conduit (Section 3.2) and scroll down to the 

physical section as shown below 

 

▪ First check if “Set Invert to Start?” and “Set Invert to Stop?” are set to “True” or “False” 

as shown below (by default they should be set to true) 

 

▪ The most used setting will be True 

▪ This means the pipe invert and the bottom of the drainage structure will match each 

other. (i.e. if the bottom of the drainage structure is changed, the pipe will 

automatically change with it) 

▪ Because the pipe outgoing from a structure (starting invert of conduit) will always 

match the bottom of the structure the “Set Invert to Start” should always be set to True 

 

▪ The “Set Inver to Stop” can be set to either True or False  

https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_3.2_Drainage_Modeling
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▪ Common situations where it will be set to false are: 

1. If the pipe into a structure is smaller, and the pipe outgoing is bigger and the user 

is matching soffits, or 

2. The pipe simply has an invert higher than the bottom of the structure for misc. 

reasons (i.e. a drop structure) 

 

If the property is set to True, follow the steps below to manually edit the invert: 

▪ Select the corresponding node (upstream node for start invert and downstream node 

for stop invert) 

▪ Open the Utility Properties for the selected node (Section 3.2) and scroll down to the 

physical section as shown below 

▪ Edit the “Elevation (Invert) (ft)” field manually to the preferred invert. 

 

▪ Close out of the node’s utility properties and open the corresponding conduits utility 

properties.  

 

▪ The conduit invert linked to that node will now match the elevation invert set by the 

user for that node, as detailed on the following page.  

https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_3.2_Drainage_Modeling
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If the property is set to False, follow the steps below to manually edit the invert: 

▪ Open the Utility Properties for the selected conduit (not the node) (Section 3.2) and 

scroll down to the physical section as shown below 

  

https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_3.2_Drainage_Modeling


 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

67 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

▪ Set the invert manually, in this field 

 

▪ The invert should be higher than the bottom of the receiving structure, if it is set higher 

then the bottom of the receiving structure, the receiving structure’s bottom elevation 

will stay constant but the pipe invert will change 

 

▪ Be careful to not set the invert lower than the bottom of the receiving structure, if it is 

set lower, the receiving box will change to be deeper with it and match the pipe 

invert. This could mess with the design of the outgoing pipes start invert. 

 

Changing Pipe Sizes  

▪ To manually set pipe sizes, use the same “Physical” properties field and simply choose 

the drop down as shown below 

▪ The pipe material can be changed in a similar manner, however be aware of  

▪ manning’s n changes (they may not update if changing it in this manner) 
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8.3 Conduits: Cross Pipes 

The “Is Culvert” Property and Procedure for Cross Pipes 

Users may notice that conduits have the option to be modeled as a “culvert” (see 

screenshot of utility properties for a conduit below). While this option may seem 

applicable to cross pipes (open end to open end), open end inlets and pipes with a 

headwall inlet, current NCDOT guidance is for this to be set to false for all conduits.  

 

▪ Although this option allows a conduit that is a cross pipe to be modeled with inlet 

coefficient losses and also checks for inlet/outlet control, users should model cross 

pipes according the latest version of the NCDOT Guidelines for Drainage Studies and 

Hydraulic Design. A cross pipe can still be input in the drainage and utilities model (for 

quantities or to connect to a median inlet), however, separate calculations shall be 

provided as noted in the guidelines. 

 

 

 

 

 

 

  

https://connect.ncdot.gov/resources/hydro/Pages/Guidelines-Drainage-Studies.aspx
https://connect.ncdot.gov/resources/hydro/Pages/Guidelines-Drainage-Studies.aspx
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8.4 Conduits: Open End Pipes / Headwalls 

Procedure for Placing Headwalls as an Inlet Opening 

As mentioned in Section 4.3, the headwall feature definitions housed within the node 

folder can be used as either inlet nodes or outlet nodes. The steps below cover special 

steps needed for open end pipes and pipes with a headwall. 

▪ Follow the steps in Section 4.1 (Node Placement), but choose a headwall feature 

definition or open end (OEP) definition (headwall selections shown below) 

 

▪ The headwall or OEP will be placed as an outlet node in the utility properties by 

default. If the headwall is to be used as an inlet node, place a conduit (Section 8.1) 

and choose the headwall as the upstream node. After placement, the headwall will 

be changed to an inlet automatically (see screenshots of the utility properties before 

and after below) 

▪ Before assigning headwall as the upstream node to a conduit: 
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▪ After: 

 

▪ Once the conduit is connected to the headwall/endwall/OEP, several other 

properties will need to be edited as outlined below. If these steps are not completed 

the software will incorrectly report the hydraulic grade line elevation at the node. Note 

this only needs to be done for headwall/endwall/OEPs. 

▪ Select the conduit and open its utility properties (Section 3.2). Navigate to the physical 

properties “Set Invert to Start?” and “Set Invert to Stop?” and ensure that one or both 

are set to false depending on which end the OEP/headwall/endwall is located.  
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▪ Select the headwall/open end node and open the utility properties. Navigate to the 

physical property “Elevation (Ground) (ft)” 

 

▪ Change the property “Elevation (Ground) (ft)” so that it is much higher than the invert 

of the pipe (this will not affect 3D view). The reason for this is due to an error where the 

HGL will only be reported up to the “ground” elevation. 

▪ The designer is welcome to add driveway pipes into the model but it is not required.   
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8.5 Conduits: Side Drain Pipe 

Standard Process for Drawing in and Modeling Side Drain / Driveway Pipe 

Side drain pipe does not typically require complex HGL calculations and creating an 

entire hydraulic network for a single, small pipe is typically unnecessary. However, due 

to the need for all proposed pipes to be shown in 3D, side drain pipe/driveway pipe 

must still be placed as if they were a network (2 nodes and a conduit). Placing a 

drainage area (catchment) and modeling the pipe is optional, but may be required by 

the reviewer on a case-by-case basis. 

Drainage areas and pipe sizing calculations (HW/D) should still be performed for side 

drain pipes if necessary, but can be done with nomographs or simpler methods as the 

reviewer allows. 

Note: Previous versions of this section stated that side drain and driveway pipes could 

be placed in a similar fashion to the pipe removal, flowable fill, and pipe plugs as 

outlined in Section 15.1. That is no longer acceptable as it does not allow for accurate 

checking of cover in the 3D model and does not work with the current DSS process and 

macros. 
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8.6 Conduits: Background Data 

Miscellaneous Pipe Components (For Informational Purposes Only) 

Similar to the node background data and components outlined in Section 4.5, conduits 

have the same two setting locations. 

▪ The Conduit Catalog is where default pipe type and size options are stored. It is 

located at Components Ribbon Tab > Catalog Drop Down > Conduit Catalog 

 

o The catalog should be used for information purposes only. Editing it should be 

done at the users own risk. It is not recommended to edit the default NCDOT 

conduits. In rare situations, conduits can be duplicated, and new ones 

created. 

 

▪ Additional Conduit properties and types are also stored in the Prototypes library 

located at the Components Ribbon Tab > Prototypes 

 

o The Prototypes library should be used for information purposes only. Editing it 

should be done at the users own risk. 
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9.1 Pipe Hydraulic Computations: Running Scenarios 

Using the NCDOT Design/Analysis Scenarios to Run 10-yr, 25-yr, 50-yr, etc. Storms 

Once all the conduit connections have been placed, a design storm is ready to be 

applied to the system. ORD Drainage and Utilities can design inverts and pipe sizes 

automatically or analyze without changing them. 

▪ To generate the proper warnings and design the system to NCDOT / Project specific 

standards, the default design constraints must be set under the Analysis Ribbon Tab 

> Default Design Constraints 

 

▪ The default design constraints dialog box will open. It is recommended these 

constraints be checked every time a new design .dgn is created. 
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▪ Below are tables with the preferred NCDOT design constraints 

 

  

Pipe Design Constraint Description and NCDOT Recommendation 

Velocity Constraints Type 
▪ Can use simple or table format (table allows different pipe sizes to 

have different velocity constraints) 

Velocity Min and Max 

▪ NCDOT does not have guidance on Min and Max Velocities – These 

can be left as is. If the user needs to set them, they should be set 

appropriately for  Geographic / topographic conditions.  

Consider Cover Along Pipe Length? 
▪ Leave unchecked - especially when your active terrain model is the 

existing terrain model 

Measure Cover to: ▪ Pipe soffit due to NCDOT minimum depth Chart 

Cover Min and Max: 

▪ Set according to most common structure on project (CB, 2GI, Etc)  For 

CB set at 1.75, to ensure 2.0’ min. cover under pavement 

▪ Note: This is the minimum cover set for all pipes. The software will 

design pipes at this depth measured from the top elevation of the 

node and generate warnings based on these criteria  

▪ If a few structures with a shallower minimum depth (such as Type-D 

2GIs) are on the project, the software may design them deeper than 

necessary. The user can then edit the elevations afterwards manually 

if needed and only a warning message will appear after that  

Slope Min and Max: 

▪ Set min to 0.005 unless in a very flat area and 0.003 is needed.  Set 

max to 0.1 at first to help identify pipes over 10% and then adjust as 

necessary. Pipe outlets may be above 10% by design and need 

adjusted manually as well. 

Include Tractive Stress Design? ▪ Leave unchecked - not needed at this time for NCDOT 

Is Part Full Design? ▪ Leave unchecked – It is preferrable to design for full flow pipes. 

Allow Multiple Barrels? ▪ Leave unchecked - multiple barrels are a very specific circumstance 

Limit Section size? ▪ Checked and set to 72" 
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▪ If the project was made in an earlier workspace, there is a setting that needs to be 

changed in the solver as outlined on the next page.  

 

  

Node Design Constraint Description and NCDOT Recommendation 

Pipe Matching ▪ Use Crowns - Unless in a very flat, elevation constrained area 

Match line offset ▪ If needed - but usually set to 0.00 

Minimum standpipe height ▪ Leave as zero 

Allow Drop Structure? ▪ Leave Checked 

Use Drop Structure to Minimize Cover? ▪ Leave checked 

Min Drop Depth ▪ Set to zero for NCDOT projects 

Inlet Design Constraint Description and NCDOT Recommendation 

Maximum Spread 
▪ Use the spread criteria most prevalent on the project according to 

the most recent NCDOT Drainage Guidelines. 

Maximum Gutter Depth ▪ Use 0.5 feet 

Min Efficiency on Grade ▪ Leave as 1% 
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▪ Navigate to the Analysis Ribbon Tab and next to the Scenarios icon is an additional 

component called Options as shown below. 

▪ Right click the properties on the NCDOT Design as shown below 

▪ Set the property “Average Velocity Method” to “Actual Uniform Velocity” 

▪ Repeat the process for the “NCDOT Analysis” Option 
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▪ Next, Open the Scenarios Manager (Section 7.1) (Analysis Ribbon Tab > Scenarios > 

Scenario Manager) 

 

▪ The two scenarios that will be used for pipe design are outlined in red above and 

defined below 

o NCDOT Design: Run this scenario on a system to have it design and change 

pipe sizes and inverts using the rules set in the default design constraints  

o NCDOT Analysis: Run this scenario to analyze a system without changing pipe 

sizes or inverts 

▪ Set the rainfall according to the project’s location for both the design and the 

analysis scenarios by right clicking them and selecting “properties” as shown below. 

Start with the 10-yr storm.  

▪ Do not change the rainfall runoff alternative for the NCDOT 4 inch/hour scenario. 
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Helpful Hint: Typically the 25-yr, 50-yr and larger return period storms should only be 

selected for the NCDOT Analysis Scenario and not the NCDOT Design Scenario. The 

analysis can be run for the 25 or 50-yr storm without changing pipe sizes and inverts and 

then HGLs can be viewed near sags. If system adjustments are needed near sags or 

cross pipes that are part of a system they can be hand edited (see Section 9.3 for hand 

editing guidance)  

 

▪ Select the NCDOT Design or NCDOT Analysis scenario and click the compute button 

outlined in red below. 

 

▪ A warning message may appear as shown below if running the design scenario. 

Click no. 
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▪ The calculations will commence and the summary dialog box will open. Click 

“messages” to view warnings or errors. 
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9.2 Pipe Hydraulic Computations: Viewing Results 

Using the Utility Properties to View Pipe Computations 

▪ After the NCDOT Design / Analysis scenario has been run, typical pipe computations 

such as pipe flow, capacity, velocity, HGL, headloss and more can be checked by 

viewing the Utility Properties. Users may also prefer to check these calculations with 

Flex Tables (guidance on Flex Tables is outlined in Section 10.1) 

▪ Open the Utility Properties for a selected conduit (Section 3.2) and scroll down to the 

results sections as shown below. 

 

▪ Typical properties of interest are shown outlined in red above. Many other 

calculation variables are available for display. 
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▪ Note: Earlier in Section 5.2, it was mentioned that when a time of concentration 

(TOC) of less than 10 minutes is entered for an inlet, the minimum TOC (10 minutes) is 

used for all flow calculations other than the cumulative system flow time. Currently, 

there exists a display error for the system intensity when the system flow time is less 

than the minimum TOC (10 minutes). As shown in the screenshot below, the “System 

Intensity“ is reported as the intensity associated with the “System Flow” time of 4.3 

minutes however, the “System Rational Flow” is reported as the flow associated with 

the intensity of the 10-minute time of concentration. The “System rational flow” is 

correct in this situation and the “System Intensity” is merely displayed incorrectly and 

should be ignored. 
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9.3 Pipe Hydraulic Computations: Adjusting the Design 

Editing System Inverts, Pipe Sizes and Other Information  

The design computed by the design scenario is not always perfect and will need 

reviewed and/or tweaked to avoid conflicts, reduce outlet velocities, etc.  

▪ If the user ran the “NCDOT Design” scenario, they can check and edit which inverts 

and pipe sizes the program changed/designed with either the utility properties 

(screenshot below) or “Stormdrain_System_All_StormRpt” flex table (Section 10.1). 

 

▪ To change inverts, simply delete the invert value in the “Invert (start)” or “Invert (stop)” 

fields and enter the new invert. Note: The “Set Invert to Start?” and “Set Invert to 

Stop?” must be set to false if it is not already in order to edit these. 

▪ To change pipe sizes simply use the drop-down list in the “Size” field 

▪ Inverts and sizes can also be edited directly within the flex tables (Section 10.1). 

▪ Remember that if a pipe material needs to be changed that the recommended 

process is to delete the conduit and replace it with a new one of that material.  
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▪ There are several ways to delete a drainage element or node 

1. Select the element and hover over the element until the quick toolbar for 

it pops up. Click the Red “X” as shown below. 

2. View the element properties. Right click the element > delete (see below) 

3. Use the explorer tool (Section 3.3) and right click the element > delete 

 

▪ Another tool that can be useful after the design has been run/completed is the Insert 

Node tool. This tool can be used to easily insert a node into an existing system and on 

top of an already designed pipe conduit. The tool will automatically split the conduit 

in two and interpolate elevations.  

▪ To use this tool, go to the Layout Ribbon Tab > Insert Node. The Insert Node dialog box 

will open as shown below. Ensure that the “Split Conduit” Option box is checked. 
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▪ The process is very similar to the Place Node tool outlined in Section 4.1 however, 

when the user gets to the step shown in the screenshot below they will be prompted 

to select the conduit to insert the node in between 

 

▪ Select the conduit and then select a location along it to place the node. Once the 

node is placed the conduit will split in two. The conduit’s end points (snap points) will 

reset and will need to be moved back to the correct sides of the structure by selecting 

the end point and snapping it to the correct side of the structure. 

▪ Both conduits will be renamed to the default naming convention and will need to be 

renamed manually. This can be done either in the element’s properties as shown 

below (first screenshot next page) or in the explorer tool (second screenshot next 

page). 
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Helpful Hint: Both the property window and the explorer tool can be used to rename 

any drainage element in the model, not just conduits. 
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9.4 Pipe Hydraulic Computations: Running Multiple Systems 

How to Handle Multiple Systems/Networks and Lock Inverts/Pipe Sizes 

Drainage and Utilities lacks the ability to easily analyze/design individual drainage 

networks one at a time when the model contains multiple networks.  By default, the 

design scenario changes inverts and pipe sizes for every network in the model and will 

overwrite any user modifications to elevations done in Section 9.3 above. To stop this 

from happening and avoid losing any user modifications, follow the recommended 

process below. 

▪ Design each system independently. Once a single system is hand modified and 

designed satisfactorily, the user will need to go to each conduit for that specific 

system and change “Design Conduit” to false. This can be done in the utilities 

properties window (see below). This must be done before running the design scenario 

to design other networks or all hand edits will be lost.  

Helpful Hint: For larger systems, custom flex tables can be used to quickly set the 

“Design Conduit” to false for multiple conduits. 
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9.5 Pipe Hydraulic Computations: Background Settings 

Miscellaneous Hydraulic Analysis Components (For Information Purposes Only) 

▪ Within the Analysis Ribbon Tab and next to the Scenarios icon are two additional 

components called Options and Alternatives 

 

▪ Options contains what are referred to as “Solvers” which are a key component of a 

Scenario. They contain more behind the scenes, in depth calculation parameters 

that will rarely be changed for NCDOT projects. 

o “Options” should be used for information purposes only. Editing it should be 

done at the users own risk. It is not recommended to edit the default NCDOT 

Solvers within “Options”. 

▪ Alternatives contains more behind the scenes variables and ways to create different 

scenarios. Like options, alternatives will be rarely be changed for NCDOT projects.  

o The most common alternative is the Rainfall Runoff. If the user wished to add 

a 100-yr, 500-yr storm or custom storm with NOAA rainfall data for a more 

accurate geographic location, they could create one here.  

o More advanced or experienced users of Stormcad may be familiar with 

Alternatives and be able to utilize them to compare different scenarios and 

designs however, in most cases Alternatives should be used for information 

purposes only. Editing it should be done at the users own risk. It is not 

recommended to edit the default NCDOT Alternatives. 
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10.1 Flex Tables: Introduction and Creation 

How Flex Tables are Used as a Summary Report 

Flex tables are used to generate summary reports on the Drainage and Utility elements. 

They can also be used to edit properties of drainage elements (elevations, pipe sizes, 

etc.) in a tabular format.  

▪ To access the flex tables, go to the Analysis Ribbon Tab > Flex Tables 

 

▪ Once the flex table dialog box opens, go to the drainage tab 
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▪ Double click on a table to open it. Note the NCDOT standard flex tables available to 

choose from.  

 

▪ Properties of elements that are not highlighted in yellow can be changed and edited 

within the flex tables. 

▪ Note: The Storm_Drain_System_All_StormRpt and other flex tables that provide system 

time calculations will show the same display error for system intensity as outlined in 

Section 9.2 (see screenshot below). 
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10.2 ORD Stormdrain System All 

NCDOT Standard Calculation Outputs 

NCDOT Hydraulics previously had an inlet and storm drain system all spreadsheet where 

the user can paste flex table .csv outputs and it will convert it to the preferred format. 

However, a newer macro-enhanced version is available. The new version is currently 

available in beta format and should have less bugs and an improved user experience. 

The previous version will still be available on the resources for ORD drainage website for 

a period of time before the new spreadsheet is deemed final. 

▪ The new, beta, excel file is available within the workspace at the following location: 

▪ The spreadsheet is consistently undergoing updates for minor bugs as they are being 

reported. If the spreadsheet is not working for the user, they should submit printout 

reports of the flex tables instead, or reach out to the support with screenshots of the 

errors (Section 16.1).  

▪ Be advised it is always the responsibility of the user to ensure the information is 

accurate with the beta spreadsheet. Please check thoroughly and report any errors. 

 

NOTE: This beta worksheet and process only works in ORD 10.12 and above. If the file 

is in ORD 10.10, the user can either upgrade it or make a copy and upgrade the copy 

in order to run this. (After upgrading and following these steps, save and restart the 

file for the item type properties to appear correctly: 

 

▪ The instructions for using the beta spreadsheet are as follows: 

 

▪ Navigate to the blank Raw Data Item type definition file in the workspace as shown 

below. 

 

https://connect.ncdot.gov/resources/hydro/Pages/ORD-Drainage-Resources.aspx
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▪ Import the file above as follows: 

 

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Attach Item as shown 

 

▪ The attach item dialog box will open. Select the ellipsis button as boxed in red below 

 

▪ The item type editor will open. Select Libraries>Import as shown below. 
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▪ Import the empty library file from the first step. 

 

▪ The "StormInlet_RawData" item types library should now be imported and appear in 

the attach item dialog box. Close out of this window 

▪ An item can be attached to any element, therefore, the user will have to sort and 

filter the active view to only show nodes and pipes to bulk select and apply the 

applicable item types to. 

▪ Isolate all the conduits/pipes as shown below (ensure nothing else is selected) 

▪ NOTE: For most situations, driveway pipes/driveway nodes should not be included in 

the inlet/storm comps – side drain pipe levels should be turned off and not included 

for the item type application. If driveway pipes are on regular RCP or Alternate levels, 

select “Yes” in the “DRIVEPIPE” property as shown below (default is always “No”). 
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▪ Attach the "StormComps" Item type to all the conduits/pipes as shown below 
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▪ Repeat the process for all the nodes as shown below (be sure to include outlet riprap 

pad cells or open end outlet pipes) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

▪ If the user accidentally attaches an item to the wrong element, use the detach item 

as shown below through the same process as highlighting and detaching. Note that 

the attach item cannot be used on an element its already been attached to unless 

it is detached first. 
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Run the Scenarios 

▪ Run the analysis scenario for the inlet computations (4 in/hr scenario) (ensure it runs 

for all the systems). 

 

Note: Be sure to check that the correct units are set in the utility properties as shown 

below (For example: Area should be acres, velociy ft/s, etc). If they are set incorrectly 

then change them, save the file, restart the ORD and re-run the analysis. 
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▪ Export the raw data as follows: 

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Import/Export as shown below 

▪ The item type import/export dialog box will open. Select “Items” (green block) and 

then export as shown below. Repeat this process if you have multiple drainage files 

(split up) and name each one accordingly so they do not get overwritten 

▪ A message should appear in the message bar showing the results of the export. (It 

may show 2/2 or 3/3 depending on if the user has other item types attached to other 

things (DSS item types, for example) 

▪ Navigate to the folder the export(s) were saved to. Example is shown below.  
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▪ Hold SHIFT and RIGHT CLICK the file. Copy as path 

▪ Click "GENERATE" in the excel sheet. Paste the file path and follow the prompts of the 

macros.  

 

Repeat for Storm Comps 

▪ Repeat this process starting at Run the Scenarios above. Run the analysis scenario for 

the 10-year storm instead of the 4. in/hr scenario.  
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11.1 Pipe Profiles: Model Creation 

Using Hydraulic Runs to Create Profiles within the Model 

In order to create a pipe profile with accompanying HGL, EGL, proposed grade, 

existing grade etc., the user must first create what is known as a hydraulic run. A 

hydraulic run is essentially an alignment that runs along the pipe corridor.  

▪ To create a hydraulic run for an entire system, go to the Layout Ribbon Tab > 

Hydraulic Runs to Outfall 

 

Helpful Hint: “The Hydraulic Run From Node” command to the left can be used to 

create profiles to/from specific nodes rather than the entire system 

 

▪ The Create Reaches to Outfall dialog box will open. The options shown below are 

the typical inputs. Node draw type “Box” will draw the nodes as boxes in profile 

view. Ensure to select the feature definition “NCDOT Proposed Pipe Profile.” 

 

▪ Select the outfall of the system to create the hydraulic run as shown below 
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▪ The proposed hydraulic run will be shown temporarily in orange, left click to accept 

▪ The hydraulic run alignment will be automatically drawn in plan view. It may be 

drawn under the existing pipes and not visible but should be there. Select it and 

hover over it until the pop-up toolbar appears. Select “Open Profile Model” as 

shown below 

▪ Open a separate view and click anywhere within that view to open the profile. The 

x and y-axis will automatically be generated as shown below. If the design or 

analysis scenarios have been run the HGL will also be plotted. 
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11.2 Pipe Profiles: Engineering and Analysis Profiles 

Opening and Customizing the Engineering and Analysis Report Profiles 

In addition to the model profile generated above which is only viewable within ORD, 

there are two other profile types (Engineering and Analysis) which can be generated 

for paper or export.  

▪ Open the explorer tool as outlined in Section 3.3 

▪ Expand the Drainage and Utilities Model section within explorer and all of its 

subcomponents. All the nodes, conduits and catchments contained within the 

model can be viewed here as well as the newly created hydraulic profile run. 

 

▪ Right click on the profile run (example outlined in red above) and the three profile 

options will be shown at the top. 

(The first option, “Open Profile Model” is what was opened in the previous Section 11.1) 
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Analysis Profile  

Engineering Profile 

 

The user can customize the labels and data shown on each to their liking and then print 

to a .pdf or export it.  
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12.1 Labeling: Drainage Labels for Plan Sheets 

Standard Labeling for Sheet Views and Drawing Scales 

 

 

NCDOT is currently in the process of developing standards for notes, callouts, and 

labeling in ORD. Future releases of this document will cover drainage labeling here. 
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12.2 Labeling: Analytic View 

Turning on Temporary Analytic Labels and Gutters for Drainage Components 

The following steps below outline how to turn on temporary labels within the model 

space to view basic drainage element names and other properties without having to 

open the properties tool for each one. 

▪ First, make sure to change annotation scale to something close to 1:1 or smaller to 

view the analytic view labels properly. Note: Changing the annotation scale to 1:1 or 

smaller should only be done temporarily and will make other labels too small to be 

viewed. The standard scales for all other labels to be viewed and placed properly is 

are the typical 1”=20’, 1”=40’ 1”=50’, etc.  

▪ Under the Drainage and Utilities Workflow go to the Drawing Production Ribbon Tab 

> Drawing Scales tool group. Change the scale as depicted in the screenshots below. 

 

▪ To turn on and off Analytic View, press CRTL+B or go to the View Ribbon Tab > View 

Attributes.  
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▪ Ensure that “Select Product” is set to “Drainage” 

 

▪ The “Symbology Definition” controls what set of drainage items are labeled and what 

type of properties (node name, catchment name, top elevation etc.) are shown in 

the labels. 

▪ To edit and create Symbology Definitions use the tool located in the Utilities View 

Ribbon Tab > Element Symbology.  

 

▪ The Element Symbology dialog box will open as shown below. Symbology Definitions 

with different property labeling preferences can be edited or created here. 



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

106 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

13.1 Views: Opening a 3D View 

Using a Second Screen or View to Check a Drainage Model in 3D 

Every Drainage and Utilities model contains 2D and 3D elements/linework. In earlier 

sections, it was recommended that the 3D reference of the active drawing (and 3D 

references of roadway design files) be turned off because design was being done in 

the 2D plan view. It can be helpful, especially with two screens, to have a 3D view open 

in tandem with the 2D view. The steps below outline how to open a 3D view. 

▪ Open a second view using the view toggles toolbar (typically docked on bottom or 

top of the screen) 

 

▪ The view will open. To change screens, left click the top left corner as shown below 

 

▪ Right click anywhere in the view and select View Control > 2 Views Plan/3D. The 3D 

view will open in view 2.  

▪ Use the view rotation tool as shown below to rotate around in 3D. 
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▪ When active in a 3D view, notice that the some of the attached 2D versions of 

references do not appear. The user will have to click in the view they want to be 

active in to turn on and off references for that view. 

▪ Reference displays are independent of each other in a 2D vs. 3D view. For example, 

a 3D reference can be turned on in the 3D view but will remain turned off in the 2D 

view and vice versa. 

▪ The 3D view can be helpful to spot check box depths or any major elevation errors in 

reference to the roadway corridor model (see screenshot below showing a catch 

basin relative to the roadway gutter in 3D).  

 

▪ If utilities are put into a 3D utility model the 3D view can be a powerful tool in 

identifying and visualizing utility conflicts with the storm drainage. 
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14.1 Proposed Ditches: Standard Ditch Modeling Process 

Designing, Drafting, and Coordinating with Roadway to Model Proposed Ditches 

 

 

Please see the separate ditch design guide on the NCDOT Hydraulics website for the 

ditch modeling process. 
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15.1 Quantities: Pipe Removal, Plugs and Flowable Fill 

Standard Process for Drawing in and Quantifying Removal, Flowable Fill Etc. 

Since pipe removals, flowable fill and pipe plugs do not require drainage areas and 

don’t necessarily need to be modeled in 3D, the process for placing these items has 

been simplified via placement of a civil element. The steps below outline how to place 

these miscellaneous drainage design quantities in the design file. 

Note: This process does not apply to side drain or driveway pipes. Side drain/driveway 

pipes must be modeled with two nodes and a conduit in 3D (See Section 8.5). 

▪ To place pipe removal or flowable fill, under the OpenRoads Modeling Workflow, 

select the Geometry Ribbon Tab > Lines > Line Between Points as pictured below. 

▪ Select the feature definition that applies as shown below 
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▪ The dialog box options for Pipe Removal and Flowable Fill are shown below 

 

▪ The name field can be left as is. For every instance of a repeat name, the software 

will simply add a number to the end of the name automatically 

▪ The pipe size can be chosen from the drop-down list or can be left blank and chosen 

later in the element properties 

▪ The alignment and station information should be left blank. This information will be 

filled out automatically at the end (covered in Section 15.2) 

 

▪ Place the line along the pipe to be removed or filled as shown in the screenshot below 
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To place a pipe plug the process is very similar except that the user will place a point 

instead of a line. Follow the steps below to place a pipe plug. 

▪ Under the OpenRoads Modeling Workflow, select the Geometry Ribbon Tab > Point > 

Point as pictured below. 

▪ The place point dialog box will open 

 

▪ The name field can be left as is. For every instance of a repeat name, the software 

will simply add a number to the end of the name automatically 

▪ The pipe size can be chosen from the drop-down list or can be left blank and chosen 

later in the element properties 

▪ The alignment and station information should be left blank. This information will be 

filled out automatically at the end (covered in Section 15.2) 

 

▪ Place a separate pipe plug on each end of the pipe that is to be abandoned 
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Pipe Removal / Flowable Fill Profiles and 3D 

The above elements are drawn as a civil geometry element therefore it has the ability 

to be assigned a vertical profile. This is an optional step that may be helpful for seeing 

proposed work in 3D. OpenRoads makes it easy is to quickly create a vertical profile by 

following the steps below. If the civil geometry is assigned a vertical profile it will be 

visible in the 3D view as a line. 

▪ First, it is recommended that an active terrain model is set 

▪ Next, select the element and hover over it until the toolbox appears as shown below. 

Select the “Open Profile Model” command. 

 

▪ Follow the prompts to open another view where the profile model will be displayed. 

The screenshot below shows the ground line profile by default which was drawn from 

the active terrain automatically 

▪  At the top of the profile view select the profile drop down as shown below and select 

“Profile Line Between Points” 



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

113 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

▪ The command will prompt to select a feature definition. Select the feature definition. 

▪ Draw the profile by placing a straight line at the start and end of the profile limits as 

shown below. The chosen start and end elevations will serve as the designed 

inlet/outlet inverts. 

 

▪ After the profile is drawn, select it and hover over it until the toolbar appears. Select 

“Set As Active Profile” as shown below. 

 

▪ The profile that was drawn is now attached to the linear element. 
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15.2 Quantities: Station & Offset 

Assigning Station and Offset Values Using the Asset Manager  

Before exporting the remove, flowable fill, and pipe plug quantities to excel, the station 

and offsets must be assigned to any drainage elements that do not already have them. 

This includes pipe removals, flowable fill, and pipe plugs. Station and offset are assigned 

through a built-in tool in ORD called the Asset Manager 

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Asset Manager as shown below 

 

▪ The asset manager dialog box will open as shown below. Select the “Open Asset 

Definitions File” icon as shown outlined in red below. 

 

▪ Navigate to the workspace folder path as shown on the next page.  

▪ Note: If the file was created in 10.10 or an early version of the 10.12 workspace, the 

property of the removes, flowable fills, and pipe plugs may be named 

“Misc_Drainage_Items”  

 If this is the case, the item type will be incompatible with the DSS. 

 Please refer to Appendix D for converting the item type to be compatible 

with the newer workspace versions 
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▪ For 10.12 and higher workspaces: 

▪ For 10.10 workspaces: 

 

▪ Open the “Remove_Plug_Fill.xlsm” file and the elements on which to populate station 

and offset will appear as shown below 

 

▪ Check all the drainage elements on the left side and then check the box “Linear 

Reference” on the right  

 

▪ Press the ellipsis button to select an alignment. This will prompt a command to visually 

select the alignment as shown below. 
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▪ Once the alignment is selected, it will show up in the dialog box as seen below.  

 

▪ Select the option box “Update Sta/Off Value” (Note: Select “Add” if applicable) 

1. The “Add” option will be used if actions from Appendix D were needed  

 

▪ If there a multiple alignments (-L- and -Y- lines) this process will have to be repeated 

for each alignment but instead of “All Elements” selected the user will have to use 

“Selection Set”, “Fence”, or “Named Boundary” as shown below to group the 

elements appropriately for each alignment 
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▪ The final step is to click “Update Assets”. A message notification will pop up at the 

bottom of the screen showing a successful addition of assets and how many elements 

have been updated (see below). 

 

▪ To verify that station and offset have been properly added, select a pipe removal, 

flowable fill or pipe plug and view its element properties (Section 3.2) 

 

▪ An example of the station and offset properties filled out is shown below. 

 

▪ Important Note: Anytime additional pipe removals, flowable fills or pipe plugs are 

added or existing ones are moved, the station and offset will need to be updated by 

running the asset manager again (repeating all the steps in this section) 

 

  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

118 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

15.3 Quantities: Raw Data Excel Export 

Exporting Drainage Quantities to Excel 

Once all station and offset values have been assigned to pipe removals, flowable fill 

and pipe plugs, the drainage summary sheet is ready to be created. To create a DSS, 

there are a few intermediate steps involved by the user. The user must first export an 

item type report following the steps below. (Note: See Appendix C if the DSS properties 

from Section 4.6 are missing to retroactively apply DSS Items) 

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Import/Export as shown below 

 

▪ The item type import/export dialog box will open 

 

▪ Select “Instance” (green block) and then export as shown below  

 

▪ Select the ellipsis button and navigate to the drainage folder for the project. 

 

▪ Hit “Export” 
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▪ A message should appear in the message bar showing the results of the export.  

▪ If the user has placed pipe removals, flowable fill or pipe plugs they will see that 2 

instances have been exported. 

 

▪ Navigate to the folder the export(s) were saved to as shown below.  

 

▪ If a project has been split up into multiple drainage files the user will want to rename 

the excel exports with a number to avoid overwriting later on (example: 

“DSS_Items_1”) 

▪ Open the newly created excel spreadsheet(s) to verify correctness. 

 

▪ The tabs at the bottom represent each drainage element as shown below. 
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▪ A screenshot of the typical quantities on each tab is shown below.  

 

 

▪ The user can close this excel sheet once the contents have been verified and move 

onto the next Section to populate the DSS. 

  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

121 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

15.4 Quantities: Generating DSS (Drainage Summary Sheet) 

Using the Macro-Enhanced DSS to Auto-Generate Quantities 

▪ Once the all the quantity export files have been created (previous section), the 

project’s DSS can be generated.  

▪ The user should begin by copying the empty DSS template from the workspace into 

their project’s drainage folder.  

NOTE: Currently, the DSS is still in beta. If the user cannot locate the ORD 

DSS_Template as shown below, try downloading the most recent workspace. If 

all else fails, a beta copy can be provided by reaching out to the contacts 

shown in the References Section. All that is asked is that the user provide beta 

feedback, thoroughly log any issues they run into and email them to NCDOT. 

▪ The empty DSS template is located within the workspace as shown below.  

 

▪ For 10.12 and higher workspaces: 

▪ For 10.10 and higher workspaces: 

 

▪ Once the DSS template has been copied and renamed for that specific project, open 

it up. 

 

▪ If the user is experiencing an untrusted file banner error when opened in excel, follow 

the steps in Appendix E 

 

▪ Important Note: the DSS worksheets are not protected, and all cells are unlocked. This 

allows the user more freedom to copy/paste and edit things manually however, 

deleting columns, renaming worksheet tab names, and changing column header 

names may cause the macros to produce errors, not work, or simply generate wrong 
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information. For more information and guidance on this, click the info and guidance 

button in the DSS spreadsheet as shown below.  

 

 

 

▪ To start, Click the button labeled “IMPORT” as shown in the screenshot below  

 

▪ Note: The import button is only located on the 48orLess tab, however, it will import for 

both the 48orLess and 54orMore items. 

 

▪ A prompt will ask to input the file path of the first item type export (as created in 

Section 15.3)  

https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_15.3_Quantities:_Excel
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▪ Notice the hint on the prompt dialog box. The path can be copied directly in this 

manner as shown below (holding shift) 

Notice that the path can be pasted with the quotes on each end as shown above and 

it will still work correctly. 

 

▪ A progress bar will appear while the data is imported. 
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▪ Once this has finished it will prompt if the user has more data to import (example: the 

pipe removal/flowable fill/pipe plug “Remove_Plug_Fill.xlsx” or another DRN export if 

the project was split into multiple DRNs) 

▪ Select the applicable choice. In this example, there was only one import and “No” 

was selected 

 

▪ To generate, Click the button labeled “GENERATE” as shown in the screenshot below 

 

▪ Note: The generate button is only located on the 48orLess tab, however, it will 

generate for both the 48orLess and 54orMore tabs. 

 

▪ The program will prompt the question below for statewide vs. non-statewide tier. 

Select the appropriate choice. Depending on the choice, the DSS header for 

alternate pipe vs. side drain will change (alternate pipe for non-statewide, side drain 

for statewide) 
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▪ The next prompt will ask if the user wants to archive the current DSS. Select “No” if this 

is the first time the user is generating the DSS or an archive is not needed. 

 

▪ A progress bar will appear while the imported data is sorted and populated in the DSS 

table 

 

▪ Be aware that while excel macros are powerful, they cannot be undone. Once they 

are run, the edit-undo functions will reset. Therefore, it is recommended to archive not 

just with this function but also make copies of the workbook in external folders if major 

changes or alternative designs are being performed. 

 

  



 

  

September 2024 Return to Table of Contents 

 

 NCDOT 

 

 

127 OpenRoads Drainage and Utilities NCDOT Quick Start Guide 

▪ Once this is complete the DSS should be populated (example on next page) 

 

▪ Check the 54orMore tab as well, the structures and pipes over 54” should be 

populated. If there are structures that need quantities filled out by hand on the 

54orMore, ensure to fill those out based on the custom sizing and standard details. 

 

 

DSS Finalization Process: User-Initiated Tasks 

DSS macros generate most of the sheet data, but some manual edits and effort are still 

required to complete the process. While future updates may enhance or automate 

these steps, for now, the following actions are necessary. 
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Rows that require user action will be flagged red in the first column as shown below. 
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DSS Pipe Elbows 

▪ If pipe elbows are proposed on the project, this will be indicated in the dump columns 

on the farthest right side of the table (outside the print area) as shown below.  

▪ This indicates that the pipe has elbows and the user must determine the size and 

manually add the pay item description + quantity in one of the light yellow, template 

headers as shown below  

Once the user enters in the pipe elbows, they should also clear the cell from the dump 

column which will automatically resolve the red warning in the first column 
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DSS Open End Pipe Nodes 

The node for an open end pipe is typically not included in the drainage summary sheet 

since the open end itself is not considered a structure and there is no pay item 

associated with it. Standard practice is to include the pipe row associated with the 

open end, but not the open end node’s row.  

▪ If open end nodes are on the project, they will generate and be flagged in the dump 

column on the farthest right side of the table as shown below. 

▪ The user should delete the row of the open end pipe by selecting a cell in the row to 

be deleted then clicking the “delete row” button as shown below.  

▪ It is recommended to use the delete row button rather than manually deleting the 

row since the macros are based on a set range of rows and columns. Deleting 

manually could potentially throw off the macros if they are ran again later. 

 

Existing Structure Nodes 

Existing structure nodes are generated in the DSS because they may act as the 

upstream node for a proposed pipe (in the case of a new pipe leaving a retained, 

existing structure). However, if an existing node does not have a proposed pipe 

associated with it, it should be deleted from the DSS manually.  
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▪ Existing nodes will flagged in the dump column on the furthest right side of the table 

as shown below. 

▪ If the existing node is deemed to need to be deleted from the DSS, the user should 

delete the row by selecting a cell in the row to be deleted then clicking the “delete 

row” button as shown below.  

▪ Otherwise, if the existing node does have a proposed pipe associated with it, it can 

be left and in the remarks column noted as “Existing structure” 
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Rows With No Data 

In some instances, particularly if the user is still using ORD version 10.10, the pipe or node 

will generate with a name, station, and elevation but no pay item quantities.  

▪ If this occurs, the row will be flagged and an error message will be shown in the dump 

column as shown below. 

 

▪ The user must add in the quantities manually in order to correct this error. 

 

▪ Once all the red flagged cells are corrected, the DSS is complete.  

 

▪ Note: The DSS must still be checked thoroughly to ensure everything has generated 

correctly. OpenRoads versions and workspace updates may produce bugs that the 

excel macros do not account for in the future. Updates to the DSS will be pushed out 

as bugs are discovered. Please reach out to NCDOT if any errors are occurring with 

screenshots or other helpful information (such as design files). 
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15.5 Quantities: DSS Printing 

Printing the DSS with the ORD Sheet Border Within ORD 

Before printing the DSS to a PDF or importing directly into a sheet model in ORD, the user 

must hide enough columns to fit the print width.  

▪ A macro has been developed to help speed up this process and hide large chunks 

of commonly unused data.  

▪ Click the button “HIDER HELPER” as shown below.  

▪ A dialog box will appear which will guide the user through asking which columns they 

want to hide as shown below.  

▪ Once the user clicks through and hides enough columns, the macro will automatically 

exit and notify the user that the print width has been achieved.  

▪ If the print width is not achieved, even after running through all the chunks of data, 

the user will be notified as such and will have to hide more columns manually.  

▪ Once the print width is achieved, the print pages are ready to be generated. Click 

the button “GENERATE PRINT PAGES” as shown below. 
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▪ Note: If the DSS has data in the 54orMore tab, the user will also have to generate print 

pages by clicking the same button on the 54orMore tab. 

 

▪ The print pages will be generated as their own tabs as shown below 

The next step is to print the DSS. While there is a button to print to PDF, the border will not 

be the most up to date. For most all NCDOT projects, the DSS should match the newest 

ORD sheet border that the project plan set uses. Since this border has elements that are 

too complex for excel, the recommended process for printing the ORD DSS is outlined 

below. 

This process will go over how to copy/paste the tables to .dgn sheet models and then 

add them to the overall print set of the project.  

▪ Navigate to the first print sheet and click the “COPY PRINT AREA” button. 

 

▪  Create and open up a blank ORD sheet model. (Steps for sheeting are outlined in 

the roadway ORD module 13 at this link) 

https://connect.ncdot.gov/projects/roadway/ord/forms/allitems.aspx
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▪ Paste into ORD by pressing CNTRL+V or right clicking and “paste from clipboard” 

▪ The following dialog box will appear.  

▪ The user can choose the options that suit their needs.  

▪ The recommended process it to choose “paste as picture” and method “by size” 

▪ “Paste as link” will create a link to the excel sheet which will update automatically, 

however, the link can break if the DSS print sheets are re-generated and it may cause 

read-only issues with the spreadsheet.  

▪ “Paste as embedded” is not recommended.  

▪ Note that any updates that take place after pasting may need to be updated by re-

pasting.  

▪ Add the sheet to the sheet print set and print through ORD. 

▪ This process can also be replicated using the printed PDF attached as a raster image  

▪ The final sheet is shown below.  

▪ Repeat this process for all sheets and then print with ORD. 
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16.1 References and Contacts 

This document is meant to be a living document that will be updated as Bentley makes 

improvements and NCDOT projects are fully transitioned to ORD software. User 

feedback, questions, and bugs/error reporting will be an important aspect of 

determining the best practices and improvements that can be made. Please use the 

contacts and links below as additional resources. 

Document Updates 

NCDOT is currently in the process of developing an email list that will send out 

notifications for when this document is updated. 

Contacts 

NCDOT is currently in the process of developing a webpage for ORD Drainage and 

Utilities which will have contacts, supplemental forms, and FAQs 

Additional Guidance / References 

NCDOT 

▪ Hydraulics Unit Homepage 

▪ CADD Services ORD Homepage 

▪ Instructional Videos (link currently in development) 

 

Bentley 

 

▪ Bentley OpenRoads Designer CONNECT Edition Document 

▪ Bentley Subsurface Utilities CONNECT Edition Help 

▪ Bentley OpenRoads YouTube Channel 

Comments and Questions 

Please direct comments and questions regarding this guide to 

HydraulicCADDSupport@ncdot.gov and a project team member will reach out. 

Beta DSS Contacts: Jordan.Bendl@kimley-horn.com & Bill.Elam@aecom.com  

Development and Updates Provided by NCDOT Hydraulics and Kimley-Horn Associates  

https://connect.ncdot.gov/resources/hydro/Pages/default.aspx
https://connect.ncdot.gov/resources/CADD/Pages/OpenRoadsDesigner.aspx
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v6/en/GUID-CF54ADA5-D625-C440-E6B9-CFB6313C54DE.html
https://docs.bentley.com/LiveContent/web/Subsurface%20Utilities%20CONNECT%20Edition%20Help-v2/en/GUID-288FAFD8-1107-4FCB-9843-8BECC9099A06.html
https://www.youtube.com/channel/UCSqfsFesjMSKXgMUEF77bLg/videos
mailto:HydraulicCADDSupport@ncdot.gov
mailto:Jordan.Bendl@kimley-horn.com
mailto:Bill.Elam@aecom.com
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Appendix A – Customized Civil Accudraw 
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Creating A Custom Civil Accudraw Option for “Unlinked” Station and Offset 

In Section 4.1, it was outlined that nodes are typically placed with a station referenced 

to an alignment and the offset is referenced to the same alignment. There are certain 

scenarios where it may be useful to have the node’s station and offset referenced to 

separate alignments. For example, a node’s station can be referenced to the -L- 

alignment but the offset referenced to the curb alignment. This can be useful when the 

-L- alignment is straight and the curb is curved or similar scenarios.   

To have this option, the user will have to create a custom option in the Civil Accudraw 

settings as outlined below. 

▪ Open the Civil Accudraw toolbar as outlined in Section 3.4 and select the Accudraw 

settings as shown below. 

▪ The Accurdraw settings will open as shown below. 

 

▪ Select the favorites tab as shown below and click “add”. 
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▪ Name the new favorite “Station-Offset Unlinked” as shown below.  

 

▪ Input the settings for the newly created “Station-Offset Unlinked” as shown highlighted 

below. 

 

▪ If the new option does not show up, toggle on and off Civil Accudraw or exit and 

open the toolbar again as shown boxed in red below 

 

Helpful Hint: Ensure Civil Accudraw is associated with the current alignment first by using 

a command that will display it such as “draw line.” If it is not associated with the current 

alignment, press the “O” key (“O” stands for “origin”) in either the station or offset data 

field, hit enter, and it will prompt the user to select an alignment. With this newly 

created option in particular, this process is more finicky, and one error is that sometimes 

entering “O” in the station field may not do anything. If this happens, follow the steps 

below: 

1. <Reset> (right click)  

2. Toggle on the regular station-offset option  

3. Enter the “O” in the offset field and not the station field 

4. Select the alignment the station should be linked to 

5. Toggle on the station-offset unlink option 

6. The station should now be linked to the alignment you chose in step 4 

If these steps fail, some form of alternating between the station-offset option and 

station-offset unlink option and entering “O” in the offset field may correct the issue. 
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Appendix B – Roadway Profile Reports 
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Using Roadway Profile Reports to Locate Crest / Sag Locations 

It is often necessary for the hydraulic engineer to mark sag/crest locations on the plan 

and use these locations to place nodes. To view a vertical geometry report of a profile, 

follow the steps below. 

▪ Ensure the roadway alignment is referenced into the current drawing and turned on 

for the main view. 

▪ Open a second view as outlined in Section 13.1 

▪ Select the alignment and hover over it until the toolbar appears as shown in the 

screenshot below. 

▪ Select the “Open Profile Model” as shown outlined in red above. 

▪ OpenRoads will prompt the user to select a view. Select the second view screen by 

clicking anywhere in it. The profile will open.  

 

▪ Select the profile and hover over it until the toolbar appears next to the cursor as 

shown in the screenshot below.  
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▪ Open the profile report. Select the “VerticalAlignmnetReview.xls” report tab (on the 

left). The crest and sag locations will be printed out on with the code “VHP” (Vertical 

High Point) and “VLP” (Vertical Low Point) with the station and elevation printed to 

the right of them as shown in the screenshot below. Other vertical geometry data is 

also printed out such as VPT, VPI, etc. 
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Appendix C –DSS For Earlier Workspace Projects 
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Retroactively Applying DSS Items to Older Projects 

If the user’s drainage project was created before the rollout of the Fall 2023 workspace, 

this section will step through how to retroactively apply item types in bulk to be able to 

follow the steps in Section 15.3 to complete the DSS.  

▪ There are two ways to retroactively apply DSS item types  

1. Use the Asset Manager (Recommended) 

2. Bulk Apply By Hand 

Both are outlined below respectively. 

1. Using the Asset Manager to Retroactively Bulk Apply DSS Items 

▪ First, ensure that the drainage design is complete and ready for item types to be 

assigned. 

▪ Additionally, ensure that any outdated item type definitions in the file are cleared out 

by following the steps below 

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Attach Item as shown below 

▪ Select the ellipsis button as shown below. 

 

▪ If there are any DSS Item Types in the active file right click and delete them as shown 

below. 

▪ The user is now ready to apply the most updated DSS Item Types  
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▪ To apply the DSS Items with the asset manager, a similar process will be followed as  

Section 15.2  

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Asset Manager as shown below 

 

▪ The asset manager dialog box will open as shown below. Select the “Open Asset 

Definitions File” icon as shown outlined in red below. 
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▪ Navigate to the workspace folder path as shown below (note: it is recommended to 

download the latest workspace for any updates to this file) 

 

▪ For 10.12 and higher workspaces: 

 

▪ For 10.10 workspaces: 

 

▪ Open the “DSS_Asset_Manager.xlsm” file and the DSS properties to apply will appear.  

 

▪ Select all the boxes as shown below then hit “Add Assets” (note: even if you do not 

have some of them on your project, it does not matter, you can check them all) 
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▪ A message notification will pop up at the bottom of the screen showing a successful 

addition of assets and how many elements have been updated (see below). 

▪ To verify that DSS Items have been properly added, select a pipe or node and view 

its element properties (Section 3.2) 

▪ The user should see a DSS property like the one shown below. Note: the duplicates 

shown below are a bug in the way the asset manager applies the item type, the DSS 

generator has been coded to delete out any duplicates in the final process.  

▪ Note: the duplicates shown above are a bug in the way the asset manager applies 

the item types, the DSS excel sheet (Section 15.4) has been coded to delete out the 

duplicates in the final process. However, any black text items (user choice) should be 

filled out twice (for example the “elbows?” choice above)  

 

▪ The user must now go through and check specific drainage elements for the user 

choice selections as needed (elbows yes/no, grate types for converts, etc.) Note that 

elbows are set to no by default so if there are no pipes with elbows they do not need 

to be changed. 

 

▪ The process is now complete, and the user should follow the steps in Section 15.3 and 

then Section 15.4 to generate the DSS 

 

▪ Troubleshooting Alignment/Station: There is a potential issue that has been 

encountered with ORD 10.10 where the DSS property’s alignment may appear blank, 

and the station would be counted from 0+00 instead of 10+00 (however, the 

alignment and station would appear correct in the other properties). To fix this issue, 

follow the steps outlined at the end of Section 4.6.  

https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/version%201.5%20(Not%20Published%20Yet)/Drainage%20Manual%20Fifth%20Draft.docx#_3.2_Drainage_Modeling
https://ncconnect.sharepoint.com/sites/HydraulicsORDDevelopment/Shared%20Documents/Development/User%20Manuals%20includes%20other%20states/NCDOT%20ORD%20Drainage%20%26amp;%20Utilities%20Manual/Version%201.6%20(In%20progress%20-%20Not%20Yet%20Published%20-%20DSS%20Incorporation)/Drainage%20Manual%20Sixth%20Draft.docx#_15.4_Quantities:_Generating
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2. Bulk Applying DSS Items by Hand (Not recommended unless Option 1 Fails) 

▪ The second option to retroactively applying DSS items is to bulk apply them by hand  

 

▪ This option takes longer and has more user effort than the asset manager process, 

however, if the asset manager process is being buggy or is no longer supported by 

Bentley in the future, this method will work by manually attaching the items. 

 

▪ First, make sure to download the latest workspace. 

 

▪ Under the OpenRoads Modeling Workflow select the Utilities Ribbon Tab and then 

Attach Item as shown below  

▪ The attach item dialog box will open. 

 

▪ If the options below aren’t appearing the user will have to select the ellipsis button as 

boxed in red below 
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▪ The item type editor will open. Select Libraries>Import as shown below. 

 

▪ Import the file at the path shown below 

▪ If the warning below appears select the options boxed in red, or click through the 

ones that are preferred to be skipped. 

 

▪ The DSS item types library should now be imported and appear in the attach item 

dialog box. 

▪ An item can be attached to any element, therefore, the user will have to sort and 

filter which drainage elements to bulk select and apply the applicable item types to. 

▪ For example, to attach the pipe DSS item in bulk, isolate all pipe levels in the active 

view (turn off all levels except pipe levels). 
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▪ Do this for all drainage items until the process is complete 
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Appendix D – Upgrading Outdated Workspace Item Types  
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Upgrading the Removes, Flowable Fills, and Pipe Plugs Item Types 

Previous workspace versions had the item type property “Misc_Drainage_Items” 

associated with the Pipe Removal, Flowable Fill and Pipe Plug feature definitions 

however, the user must update the item type property to the “Remove_Plug_Fill” item 

type for the DSS to generate correctly. Follow the steps below to upgrade the item 

type. 

▪ Under the OpenRoads Modeling or Drainage and Utilities Workflow select the Utilities 

Ribbon Tab and then Attach Item as shown below 

 

▪ Select “Browse” 

 

▪ Delete the Item type called “Misc_Drainage_Items” 

▪ Confirm the delete. 

▪ Attach the new item type “Remove_Plug_Fill” to all the items by following the steps in 

Section 15.2 
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Appendix E – DSS: Troubleshooting VBA Permissions 
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Troubleshooting Excel VBA Macro Permissions 

In certain instances, Microsoft excel blocks an excel file thinking it was downloaded 

from an untrusted source (especially if that excel file contains macros). If the user is 

experiencing trouble getting macros enabled and sees the following message at the 

top of the DSS excel sheet, follow the steps below. 

▪ Note: NCDOT employees will not have the following option as shown below and 

should skip to the next page 

▪ Navigate to the file in file explorer and right click the file. 

▪ Open the properties and unblock it as shown below. 

 

▪ If this still does not work, follow the steps below. 

▪ Launch excel and go to file > options. 
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▪ Select Trust Center > “Trust Center Settings” as shown below 

 

▪ Macro settings and trust settings are shown below. 

▪ (NCDOT employees will need to locate the trusted location tab as shown below and 

move the spreadsheet to that location and try opening it again.) 

 

▪ The user should adjust these as necessary which may solve the issue. 
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Appendix F – Converting Geopak to ORD w/ Model Builder 
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Using Model Builder to Convert Geopak to ORD 

NCDOT Hydraulics has developed a way to convert a project from Geopak drainage in 

MicroStation to an ORD D&U file.  

▪ The process is outlined in the following data set folder download available on the 

NCDOT Hydraulics website 

https://connect.ncdot.gov/resources/hydro/ORDFiles/GEOPAK%20Drainage%20to%20

ORD%20Drainage%20and%20Utilities%20Converter%20Tool.zip 

 

▪ The process still has some steps required by the user to perform manually and some 

minor bugs however, it will save the user a decent amount of time and bring in the 

base elements.  

 

  

https://connect.ncdot.gov/resources/hydro/ORDFiles/GEOPAK%20Drainage%20to%20ORD%20Drainage%20and%20Utilities%20Converter%20Tool.zip
https://connect.ncdot.gov/resources/hydro/ORDFiles/GEOPAK%20Drainage%20to%20ORD%20Drainage%20and%20Utilities%20Converter%20Tool.zip
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